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Objective 
 
The primary purpose of this Guide is to gather and present 
factual materials in such a manner that project officers, 
both professional and technical, could obtain a common 
reference of the various practices on the adoption of BIM 
in quantity surveying for building projects undertaken by 
the Quantity Surveying Branch of the Architectural 
Services Department. 
 
Disclaimer 
 
Whilst the Architectural Services Department endeavours to ensure 
the accuracy of the contents in this Guide, no expressed or implied 
warranty is given on the accuracy of any of its contents and there is 
no representation, either expressed or implied, as to the suitability 
of the said information and data for any particular purpose.  It is 
hereby stated expressly that the department does not approve, 
recommend, endorse or certify the use of any of the information and 
technologies contained in or in connection with this Guide. 
 
Users are responsible for making their own assessments and 
judgement of all information contained in or in connection with this 
Guide and are advised to seek independent verification as to its 
accuracy, currency or completeness.  The department accepts no 
liability for any use of the said information and data or reliance 
placed on it.  The department does not accept any responsibilities 
for any special, indirect or consequential loss or damages 
whatsoever arising out of or in connection with the use of this Guide. 
 
The Architectural Services Department reserves the right to omit, 
edit or update the Guide at any time in its absolute discretion without 
any prior notice. 
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1. Introduction 
 
1.1 Overview 
 

This Building Information Modelling (BIM) Guide for Cost Estimation documents the general requirements, 
guidelines and practice for Quantity-Take-Off (QTO) by BIM models in which the quantities extracted 
comply with the current industry practice as far as possible for building projects managed by Architectural 
Services Department (ArchSD) in order to achieve the following objectives:  
- to stipulate the required settings and configurations of BIM models for cost estimation 
- to improve the functionality of BIM models to facilitate the process of QTO  
- to achieve consistency of cost estimation by BIM models 

This BIM Guide for Cost Estimation (hereinafter called “The Guide”) is formulated base on locally 
recognized BIM standards, guidelines and industry practices.  While BIM is under rapid development, 
this Guide shall be subject to regular review and update to suit the latest development of BIM. 
 

1.2 Reference BIM Standards and Guidelines 
 
This BIM Guide for Cost Estimation shall be read in conjunction with the current versions of the followings 
issued by Architectural Services Department: 
 
(a) BIM Guide for Architectural Design 
(b) BIM Guide for Building Services Installations 
(c) BIM Guide for Structural Engineering 
(d) BIM Guide for Facilities Upkeep 
 
This Guide has made referenced to the following local standards and guidelines: 
 
(a) Development Bureau Technical Circular (Works) No. 02/2021 - Adoption of Building Information 

Modelling for Capital Works Projects in Hong Kong 
(b) Development Bureau Technical Circular (Works) No. 08/2021 – Building Information Modelling 

Harmonisation Guidelines for Capital Works Projects in Hong Kong 
(c) Hong Kong Standard Method of Measurement of Building Works – Fourth Edition Revised 2018 

(SMM4) published by the Hong Kong Institute of Surveyors  
(d) Standard Method of Measurement for Building Elements published by the Architectural Services 

Department 
(e) Standard Phraseology for Bills of Quantities for Building Works - 2022 Edition published by the 

Architectural Services Department 
(f) CIC Building Information Modelling Standards – General (Version 2.1 –2021) issued by Hong 

Kong Construction Industry Council. 
(g) CIC Building Information Modelling Standards for Architecture and Structural Engineering 

(Version 2.1 – 2021) issued by Hong Kong Construction Industry Council. 
(h) CIC Building Information Modelling Standards for Underground Utilities (Version 2 – 2021) issued 

by Hong Kong Construction Industry Council. 
(i) CIC Building Information Modelling Standards for Mechanical, Electrical and Plumbing (Version 

2 - 2021) issued by Hong Kong Construction Industry Council. 
(j) CIC Production of BIM Object Guide - General Requirements (Version 2 – 2021) issued by Hong 

Kong Construction Industry Council. 
(k) CIC BIM Dictionary (2021) issued by Hong Kong Construction Industry Council 
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1.3 Abbreviation and Terminology 
 

The abbreviations and terminology /glossary shall refer to the CIC BIM Dictionary. 
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2. General Modelling Guidelines 
 
2.1 General 

 
Quantity Surveyor (QS)’s early input in the modelling process is imperative to ensure the BIM models are 
developed with proper geometry and key information for effective cost planning. 
 
A BIM model contains graphical (2D/3D objects) and non-graphical (object data) information that can be 
extracted for quantification. The design author needs to create, place and export their models in a way 
that enables this information to be used for quantification purposes. 
 
There are many BIM authoring software packages in use which produce their own proprietary native file 
type. Various interoperable file types exist which can be read by different estimating and quantity 
surveying packages thereby enabling data from BIM files to be leveraged whatever the originating design 
software. The most common interoperable BIM file types are DWFTM, DWFxTM and IFC formats. 
 
The following are some important points to note when creating a BIM model: 
 
a. Project Units 

To provide an accurate cumulative total the Project Units need to be set to two or more decimal 
places to avoid each dimension being rounded off. 

 
b. System Assemblies 

Layered elements such as walls, floors, flat roofs, etc. are invariably modelled as assemblies. When 
exported to a DWFxTM an assembly appears as a composite whole and its component parts are not 
separately identified. It is very important that the component details are communicated in full by 
using descriptive Object or Type naming conventions or providing assembly information on detailed 
2D sections or schedules. Alternatively, Parts may be used. 

 
c. Parts 

The Part function is designed to support aspects of construction workflows such as pour schedules 
for example, by enabling a slab to be separated into parts based on the pour sequence. However, 
Parts can also be used to separate System Assemblies into their component elements so that 
rather than one composite floor slab assembly, say, the DWFxTM will comprise of separate elements 
for fill, insulation, moisture barrier, structural concrete, and screed. 

 
d. Rooms and Areas 

Room and area data is extremely useful for estimating purposes, particularly during the earlier 
design stages where rates/area are used to develop budget estimates. 

 
e. Shared Parameters 

Shared Parameters may be added to enrich the data included in the DWFxTM file with additional 
information or specific coding, such as element or rate codes, for each object in the model. 
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If the model contains linked CAD files with multiple instances of a typical object or group of objects, the 
multiple instances may all have the same ID. These duplicate IDs may affect the quantities included in 
the exported file provided to the QS. For example, if a typical apartment is repeated twenty times in a 
model and the IDs are duplicated, the quantities given may only relate to one apartment, not twenty. For 
this reason, the duplicate IDs in BIM model should be removed before exporting the DWFxTM file. 
 
There are some more general modelling guidelines as follows: 
 
a. Align function is a command in organizing all elements which can ensure the elements to be 

enclosed and eliminate the gap between different objects. 
 

b. Accurate naming of objects and elements. Object names should be accurately described the 
makeup, materials and size of the object (e.g. 10mm pbd / 92mm stud / 10mm pbd). 
 

c. Objects/elements are to be modelled as they will be constructed where practical. 
 

d. As there may be elements from the same object without indication of the floor they belong to, each 
element shall be defined with appropriate levels. 
 

e. For creating structural elements, grid system shall be utilized from the beginning in order to follow 
the arrangement of structural elements which means the beams and columns shall be placed in 
grid form with beams between columns. 
 

f. Model should be created in an accurate manners, snap function and key in actual figures is 
preferable, instead of drafting by visual judgement. 
 

g. Floors and their elevations or floor height should be defined.  
 

h. All model objects can be split between Existing, Temporary Works, Demolition and New Works 
(including staging if applicable). 
 

i. All instances should be divided floor by floor. 
 

j. Apart from the modelling guidelines as detailed in this document, the structural model should be 
created to tally with the assumptions for structural design, e.g. load path. 
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2.2 Objects 
 
The modelling guidelines for Objects are as follows: 
 
a. When available, built-in Objects should be used. 
 
b. When a new Type is created under an Object, the description of the Type should be in a consistent 

format. 
 
c. Similar to the built-in Objects, some basic dimensions should be included in the description of each 

Type, i.e. width and depth of beam should be stated in the description of each Type of “M_Concrete-
Rectangular Beam”. 

 
d. When creating a new element, similar object shall be selected but not creating a new and generic 

object. The reason is that when creating a new object, the parameter may not be as complete as 
the similar object, e.g. when creating a tapered beam, architects shall utilize a rectangular beam to 
modify as a tapered beam. 

 
 

2.3 Architectural Design Modelling 
 
a. Architectural Concrete Works  

 
i. For non-structural walls, they shall be created up to the underside of beams or slabs which 

is different from modelling structural walls. 
 

ii. Concrete grade should be identified. 
 

iii. Curved or battering elements should be identified by additional parameters. 
 

b. Partitions & Linings 
 

i. Type of wall should be identified. (For example: material of wall & bond of blockwall) 
 
ii. Fire rating should be provided if the wall is a non-concrete wall. 
 
iii. If additional supporting frame is required conditionally, those partitions with such supporting 

frame should be identified. 
 

c. Doors, Windows and Louvres 
 

i. For door, information for ironmongeries should be included (hardware set code could be 
considered). 

 
ii. Door marks and window marks should be provided to differentiate the types of door and 

window. 
 
iii. Fire rating should be provided. 
 
iv. Insulation requirement, such as acoustic and thermal insulation, should be provided. 
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v. Additional features, such as wind guards, fire dampers, mesh covers, etc., should be 

identified. 
 
d. Handrails, Balustrades, Ladders and Stairs 

 
i. Railing mark should be provided to differentiate the types and material of railing. 
 
ii. The diameter / thickness of railing should be identified. 

 
e. Curtain Wall and Glass Wall, Claddings and Coverings 

 
i. Cladding marks and curtain wall marks should be provided to differentiate the types and 

material of Cladding and Curtain wall. 
 
ii. Opening and doors for cladding and curtain wall should be identified. 
 

f. Furniture and Fittings 
 

i. Furniture mark should be provided to differentiate the types of furniture. 
 

ii. Material and overall size for furniture should be identified  
 
g. Internal Finishing 

 
i. Use room element (Room Tag) to quantify and schedule the finishes in each room and 

ensure that the room boundary is set in accordance with the required use. (for Construction 
Floor Area or Internal Area) 

 
h. Roof 

 
i. Depth of green roof should be stated. 

 
i. Landscaping Works  
 

i. Existing tree marks, name and the tree treatment of the existing trees should be provided. 
 
ii. Tree code for new planting tree should be provided. 
 
iii. When modelling shrubs, bamboos, climbers and like, using “Floor” to indicate the planting 

area and type of plant should be identified. 
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2.4 Structural Engineering Modelling 
 
a. Level of Structural Model 

 
i. Once the modelling of existing site terrain provided, the structure elements shall be drawn 

on the site terrain with actual mPD. 
 

b. Concrete Works 
 
i. When creating concrete works, the concrete grade shall be incorporated as a separate 

parameter. 
 

ii. For liquid retaining structure, should be specified in separate parameter. 
 
iii. Provide separate parameter for concrete works with curved shape (curved wall and beams), 

sloping (slab for ramp and inclined beam). 
 
iv. Separate parameter should be added for transfer plate. 

 
c. Structural Steel 
 

i. Type, grade and size of structural steel members should be provided. 
 

ii. When creating the structural steel connections, type, size and length of bolts should be 
identified as far as practical. 

 
2.5 Building Services Installations Modelling 
 

a. Air Conditioning and Mechanical Ventilation System 
 

i. Reference code and other essential information should be provided for equipment. 
 

ii. Separate 3D views should be created for typical floor/ typical room/ plant room area. 
 

b. Electrical Installation 
 

i. Type, reference code and rated capacity should be provided for equipment. 
 

ii. Type and reference code should be provided for lighting. 
 

c. Fire Service Installation 
 

i. Type and reference code should be provided for equipment. 
 

ii. Type of sprinkler heads should be identified. 
 

iii. Capacity for fire service water tank (excluding RC tank) should be identified. 
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d. Above ground plumbing and drainage works 
 

i. Type of surface channel should be identified. 
 
ii. Width of channel should be provided. 
 
iii. Finishing of surface channel should be identified.(open channel/ cast-iron/ matching cover) 
 

e. Underground drainage works 
 

i. All underground drainage BIM model should contain underground drainage elements shown 
on the drainage layout only.  Other building elements are assumed containing in other 
discipline BIM models. 
 

ii. Underground drainage elements shall use the Principal Datum level as the reference level.  
It is not necessary to specify another reference level to place the pipe to minimize the number 
of reference level and complexity of the model. 
 

iii. Reference code should be provided for manholes.  Inspection chambers, soakways, 
sealed trapped gully and the like should be identified in the object and type name. 
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3. Detailed Modelling Guidelines – General 
 
The detailed modelling guidelines divide into three part – Architectural Design, Structural Engineering 
and Building Services Installations. Each building element would be illustrated into three section (1) Basic 
information, (2) Modelling approach and (3) Quantity Take-off. 
 
(1) Basic information 

 
This section focuses on the setting out of the Category of building elements, sequence for the 
modelling and Level of Development of each element (only applicable for those elements not yet 
defined in other BIM Guide). 
 

(2) Modelling approach 
 
This section demonstrates the most common modelling approach in the industry and specifies the 
properties required for the elements to facilitate QTO. 

 
(3) Quantity Take-off 

 
This section provides the technique and explanatory notes for QTO from the BIM Model. The 
methodologies described in this section are based on the modelling approach described in Section 
(2). Do not follow indiscriminately. Quantity surveyors shall execute their own professional judgment 
and make necessary adjustments. 

 
Section (1) and (2) focus on the modelling information which are required from models while section (3) 
is a step-by step guide to assist quantity surveyors to measure quantities from BIM models.  
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4. Detailed Modelling Guidelines – Architectural Design 
 
4.1 Architectural Concrete Works 
 

This section mainly focuses on the following: 
i. Architectural Walls 
ii. Ramp 
 

4.1.1 Basic Information 
4.1.1.1 Building Element to Model 

Modelling elements: 

Elements Object Category 

Work Description Manage/ Settings/ Materials 

Architectural Walls/ Curbs/ Partition Walls Wall: Architectural 

Ramps Ramp: Architectural 

 
4.1.2 Modelling Approach 
4.1.2.1 Architectural Walls 
4.1.2.1.1 Type Naming 

Walls is a built-in name of the system object. 

Format: 
<Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Type Name AWL-ADA-CONCB_100mm_60FRR-__ Descriptions 

Functional Type AWL-ADA-CONCB_100mm_60FRR-__ AWL is the short form of the functional 
type “Architectural Wall” 

Originator AWL-ADA-CONCB_100mm_60FRR-__ ADA for architectural discipline of 
ArchSD 

Descriptor 1 AWL-ADA-CONCB_100mm_60FRR-__ The wall is made of Concrete 
Blockwork (material) in 100mm thick 

with -/60/60 fire resistance rating.  

Descriptor 2 AWL-ADA-CONCB_100mm_60FRR-__ 2-digit sequential number to distinguish 
different types, if Descriptor 2 is blank, 
two underscores (__) should be used. 

 
Functional Type Descriptions 

AWL Architectural Wall 

PAW Architectural Partition Wall 

CUB Curb 

STW Structural Wall 

RTW Retaining Wall 
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Descriptor 1 Descriptions 

CONC Concrete 

CONCB Concrete Blockwork 

GLASSB Glass Blockwork 

 
4.1.2.1.2 Sequence of modelling 

 

 
 
* Keeping original structural workset in ARC model as "hidden workset" instead of deleting the structural workset 

in ARC model is preferable as the impact to wall hosted elements can be minimized. 
 

Step 1 
 
Architectural tab  Wall  Wall: Architectural 
 
 
 
 
 
 
 
Step 2 
 
Define Base Constraint, Top Constraint, Base Offset and 
Top Offset 
 Base constraints: should be set to the level where 

walls are sit on  

 Top constraints: should be set to either the floor 

level immediately above for full height walls and 

hanger walls, or unconnected for non-full height 

walls, parapets and curbs 

Step 3 
 
In Project Browser, select the floor plan view of “Base Constraint” in step 2 above 

Early Stage (Before Structural Engineer on board)

• Create structural wall and non-structural wall in architectural (ARC) model with 
different worksets (for design intention and drawing production)

• Apply wall finishes to the wall as appropriate

Later Stage (After Structural Engineer on board)

• Create structural wall in structural (STR) model (with loading calculation)
• Link ARC model with STR model
• Keep original structural workset in ARC model as a "hidden workset" *
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(a) Straight Wall / Curved Wall 

Step 4 
 
Select the drawing method under “Modify | Place Wall > Draw” and draw on plan 

 
 

(b) Sloping Wall 

Step 5 
 
Select the wall that needs to be sloped, in Properties, choose “Slanted” in Cross-Section 
 

 
 
Step 6 
 
Define the angle of the sloping wall 
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4.1.2.1.3 Wall Joint 
 
 The “Wall Joins” command under Modify > Geometry helps to modify the wall joints method to the 

appropriate type.  

 

 Different types of wall joint could be obtained by selecting among (i) Butt, (ii) Miter or (iii) Square off.  

 

Butt Miter Square off 
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 Despite the fact that different types of wall joint will affect the area and the volume of the wall, it 

should be noted that for quantity take-off purpose, different wall joint methods do not affect or do not 

have significant impact on the total volumes. The “Area” shown in the program and above are the 

wall surface area of the outer sides, as marked in green dotted lines. 

 

 For “Area”, the program’s built-in definition appears to be calculated from the product of length and 

height of the wall reference line, for a standard rectangular standalone wall, i.e., this will be the wall 

surface area of one face only instead of both faces. Where two walls are joined and there are different 

surface areas for two faces, the area also represents either one side of the face only, depends on 

the wall joint method being applied. Users should be aware of the systematic difference if extracting 

the area data for QTO or other purposes. 
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4.1.2.1.4 Joint Geometry 
 
Joint Geometry is one of the essential commands between joined elements, although from elevation of 
these 2 walls seems no difference, but the actual geometry and the schedule shows the difference 
between the un-joined wall and the joined wall. 
 
Un-joined Wall: 
 

 
 
Joined Wall: 
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4.1.2.2 Ramp 
4.1.2.2.1 Type Naming 

Ramp is a built-in name of the system object. 

Format: 
<Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Type Name RAP-ADA-CONC_12-__ Descriptions 

Functional Type RAP-ADA-CONC_12-__ RAP is the short form of the functional type “Ramp”. 

Originator RAP-ADA-CONC_12-__ ADA for architectural discipline of ArchSD. 

Descriptor 1 RAP-ADA-CONC_12-__ The ramp is made of Concrete with 1:12 slope for 
disabled access. 

Descriptor 2 RAP-ADA-CONC_12-__ 2-digit sequential number to distinguish different 
types, if Descriptor 2 is blank, two underscores (__) 

should be used. 
 

Functional Type Descriptions 

RAP Ramp 

ARF Architectural Ramp Finishes 

ASR Architectural Finishes + Structural Ramp 
 

Descriptor 1 Descriptions 

STL The ramp is made of steel. 

Material Material of ramp finishes, e.g. porcelain tiles. 
 
4.1.2.2.2 Sequence of modelling 

Ramp consists of architectural finishes and structural ramp. 
Architect is required to create structural ramp at early stage 
(Before Structural Engineer on board) of the project. After 
structural (STR) model is linked with architectural (ARC) 
model, original structural ramp modelled by architect could 
be modified to architectural ramp finishes by changing the 
Ramp Type setting (including thickness, base offset, top 
offset, etc.). 
 
If the gradient of a slope is greater than 1:21, ramp should be used for 
modelling. 

 

Early Stage (Before Structural Engineer on board)

• Create structural ramp/mass concrete fill ramp in ARC model 
(for design intention and drawing production)

Later Stage (After Structural Engineer on board)

• Create structural ramp in STR model (with loading calculation)
• Link ARC model with STR model
• Modify original structural ramp in ARC model to ramp finishes on top of the
linked structural ramp or apply ramp finishes to mass concrete fill ramp
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4.1.2.2.3 Setting of creating Ramp 
 

Create a ramp in a plan or 3D view by sketching the run of the ramp or by sketching boundary 
lines. 
 
Step 1 

Architecture tab Circulation panel   (Ramp).  

 
 
Step 2 

The default settings for the ramp (Top Level = Upper Level) may make the ramp too long. 
e.g. 1:12 ramp, the length of ramp will be 48m 
 
 
 
 
 
 
Thus, set the Top Level to the current level, and the Top Offset to the offset distance from top level. 

 
 

1:12 
4m 

48m 
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Step 3 

Click Modify | Create Ramp Sketch tab Draw panel, and select either   (Line) or   (Center-ends 
Arc). 

 
Place the cursor in the drawing area, and drag to sketch the ramp run. 

 
 

Step 4 

Click  (Finish Edit Mode).  
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Step 5 

The following typical parameters shall be set: 

Under Properties> Dimensions 

Parameter Type / Instance Description 

Width Instance Be aware of width whether including or not 
including handrails. 

Under Type Parameters > Materials and Finishes 

Parameter Type / Instance Description 

Ramp Material Type  

 
Step 6 

The following parameters shall be set in a mass concrete fill ramp. 
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4.1.3 Quantity Take-off 
4.1.3.1 Architectural Walls 

Step 1 
 
Create a new Walls Schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 
 

 
 
Sample of Wall Schedule 
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Step 2 
 
Schedule Properties and Setting 
 
 Fields 

 

 
 Sorting/Grouping 
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4.1.3.2 Ramp 
4.1.3.2.1 Mass concrete fill to form ramp 
 

 
4.1.3.2.2 Floor slab to form ramp 
 

 
 

Step 1 
 
Measure the length on plan view. 

 
  

Cast in place concrete ramp would be 
included the Structural Model and 
measured as structural elements 

Mass concrete fill ramp would be 
measured as architectural concrete 
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Step 2 
 
Create a new Ramps schedule, refer to Part 7 Techniques for QTO – 7.4 Schedule/ Material Take-off. 

 
 
Sample of Ramp Schedule 

 
 

 
Step 3 

Schedule Properties and Setting 

 Fields 

 

Input manually 
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 Add new parameters to schedule. 

 
 

 Calculated Value 

Set formula for the parameter.  

 
 Sorting/Grouping 
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4.2 Partitions & Linings  
 
This section mainly focuses on the following partitions: 
i. Brickwork and Blockwork (covered under Part 4 Detailed Modelling Guidelines – Architectural Design – 4.1 

Architectural Concrete Works) 
ii. Sliding and Folding Partitions (covered under Part 4 Detailed Modelling Guidelines – Architectural Design – 

4.3 Doors) 
iii. Toilet and Shower Cubical Partitions 
iv. Fixed and Demountable Partitions 

 
4.2.1 Basic Information 
4.2.1.1 Building Element to Model 

Modelling elements: 

Elements Object Category 

Work Description Manage/ Settings/ Materials 

Toilet and Shower Cubical Partitions Component: Generic Models: Plumbing Fixtures 

Fixed and Demountable Partitions Component: Generic Models: Furniture Systems 

 
4.2.2 Modelling Approach 
4.2.2.1 Toilet and Shower Cubical Partitions 
4.2.2.1.1 Object Naming 

Toilet and Shower Cubical Partitions can be created with generic models template and categorized in 
Plumbing Fixture. 

Format: 
<Category> - <Functional Type> - <Originator> - <Descriptor 1>- <Descriptor 2> 

Object Name PLM-TPT-ADA-ToiletPartition-01 Descriptions 

Category PLM-TPT-ADA-ToiletPartition-01 PLM is the short form of the 
Category type “Plumbing Fixture” 

Functional Type PLM-TPT-ADA-ToiletPartition-01 TPT is the short from of “Toilet 
Partition” 

Originator PLM-TPT-ADA-ToiletPartition-01 ADA for architectural discipline of 

ArchSD 

Descriptor 1 PLM-TPT-ADA-ToiletPartition-01 

 

A fixture of toilet partition.  

Descriptor 2 PLM-TPT-ADA-ToiletPartition-01 2-digit sequential number to 
distinguish different types. 
Type 1 of the toilet partition 
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4.2.2.1.2 Sequence of modelling 
The sequence of modelling: 
Architectural tab  (1) Component  (2) Place a Component  (3) Choose the partition type in 
Properties  (4) Draw the path on plan 

 
 
4.2.2.2 Fixed and Demountable Partitions 
4.2.2.2.1 Object Naming 

Fixed and Demountable Partitions can be created with generic models template and categorized in 
Furniture Systems. 

Format: 
<Category> - <Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Object Name FNY-PRT-ADA-FixedPartition-01 Descriptions 

Category FNY-PRT-ADA-FixedPartition-01 FNY is the short form of the category 
type “Furniture Systems” 

Functional Type FNY-PRT-ADA-FixedPartition-01 Partition is the short from the 
functional type of “Partition” 

Originator FNY-PRT-ADA-FixedPartition-01 ADA for architectural discipline of 

ArchSD 

Descriptor 1 FNY-PRT-ADA-FixedPartition-01 A fixture of fixed partition.  

Descriptor 2 FNY-PRT-ADA-FixedPartition-01 2-digit sequential number to 
distinguish different types. 

Type 1 of the fixed partition. 

(1) 

(2) (3) 
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4.2.3 Quantity Take-off 
4.2.3.1 Toilet and Shower Cubical Partitions 

 
Step 1 
 
Create a new Plumbing Fixtures Schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material 
Take-off. 
 

 
 
Sample of Plumbing Fixtures Schedule 
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Step 2 
 
Schedule Properties and Setting 
 
 Fields 
 

 
 
 Sorting/Grouping 
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4.2.3.2 Fixed and Demountable Partitions 
 
Step 1 
 
Create a new Generic Models Schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 
 

 
 
Sample of Generic Model Schedule 
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Step 3 
 
Edit Family 
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Step 3 
 
Schedule Properties and Setting 
 
 Fields 

 

 
 
 Sorting/Grouping 

 

  
 



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 33 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date: Dec 2023 

 

4.3 Doors 
 
This section mainly focuses on the following doors: 
i. Timber Door 
ii. Metal Door 
 

4.3.1 Basic Information 
4.3.1.1 Building Element to Model 

 
Modelling elements: 

Elements Object Category 

Work Description Manage/ Settings/ Materials 

Door Door 

 
 

4.3.1.2 Sequence of modelling 
 
The sequence of modelling: 

Create new object  Door  Add Parameters  Create wall in Project  

 Load into Project  Add door 

 Door is a wall host component; 
 Door in a curtain wall shall be created from curtain panel; 
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4.3.2 Modelling Approach 
4.3.2.1 Object Naming 

Details of naming convention shall refer to Section 4.9.2 of BIM Guide for Architectural Design issued by 
Architectural Branch, Architectural Services Department. 

Format: 
<Category> - < Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Object Name DOR-SGL-ADA-WD-01 Descriptions 

Category DOR-SGL-ADA-WD-01 A Door, DOR is the short form of the 
Category type “door” 

Functional Type DOR-SGL-ADA-WD-01 A Single Door, SGL is the short form of 
the functional type “single” 

Originator DOR-SGL-ADA-WD-01 ADA for architectural discipline of 
ArchSD 

Descriptor 1 DOR-SGL-ADA-WD-01 A door is made of Wood (WD) 
(material).  

Descriptor 2 DOR-SGL-ADA-WD-01 Type 1 of the wood door. 

 

Functional Type Descriptions 

SGL Single Door 

DBL Double Door 

SLD Sliding Door 

SDL Sidelight Door 

 
4.3.2.2 Type Naming 

 
Format 

<Width>mm x <Height>mm 

Single Swing Door: 

Type Name Descriptions 

850mm x 2150mm 850mm Door Width 

2150mm Door Height 

 

Double Swing Door: 
Type Name Descriptions 

1500mm x 2150mm 1500mm Door Width 

2150mm Door Height 

600/800mm x 2350mm 600mm Left Door Width 

800mm Right Door Width 

2350mm Door Height 

 
  



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 35 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date: Dec 2023 

 

 
4.3.2.3 Setting of creating a Door 

 
Door shall be modelled to its designed size with suitable parameters to allow computation of the size of 
structural opening, door leaf and door frame. The following parameters shall be set in Door objects: 

Under Construction 

Description Parameter Timber Door Metal Door 

Interior/ Exterior Function  

Number of door panels 
(for sliding partition only) 

No. of door panels  

Under Materials and Finishes 

Description Parameter Timber Door Metal Door 

Material of Door leaf Door Panel Material#  

Material of Vision panel Vision panel Material#  

Material of Door Frame Door Frame Material#  

Material of Louvre Louvre Material#  

# The information inserted in the parameter Material is for rendering purpose only, please refer to 
door details for the type of material. 

Under Dimension 

Description Parameter Timber Door Metal Door 

Door leaf width Primary Door Width  

2nd Door leaf width for 
double leaves door 

Secondary Door Width  

Each door panel width 
(for sliding partition only) 

Door panel width  

Door leaf height Door Height  

Door leaf thickness Door Panel Thickness  

Structural opening width Structural opening width 
(by formula) 

 

Structural opening height Structural opening height 
(by formula) 

 

Overall vision panel width 
including frame 

Vision panel width  

Overall vision panel 
height including frame 

Vision panel height  

Louvre width Louvre width  

Louvre height Louvre height  
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4.3.2.3 Setting of creating a Door (Cont’d) 

Under Fire Protection 

Description Parameter Timber Door Metal Door 

Fire Rating of Fire-Rated 
door 

Fire-Rated door  

Under Identity Data 

Description Parameter Timber Door Metal Door 

Ironmongery set mark 
(Detail refer to 
Ironmongery Schedule) 

Ironmongery set  

Door type mark Type Mark 
(Built-in Parameter) 

 

Note: 

1. Models for architraves, door frame, thickness of visual panel, louvre blades and ironmongery are 
for geometrical indication only, please refer Detailed Drawings for actual dimension 

2. A parameter Door Mark for SCCU Submission under Fire Protection are for statutory submission 
only, door mark shall refer the instance built-in parameter Mark for each door. 

3. Formula for Structural opening: 

Parameter Calculate Formula 

Structural opening width@ = Door Width + 2*(Door Frame and Rough Filling Width) 

Structural opening height@ = Door Height + Door Frame and Rough Filling Width + Floor 
Finish Thickness 

Clear Width (for reference) = Primary Door Width – Door Panel Thickness 

 

 

 

 

 

 

 

 

 

 

 
@ The formula subject to adjust where the door frame is not regular shape in model. 

 

Parameter Default Dimension 
Door Frame and Rough 
Filling Width (A) 
 

= 75mm 
 

Door Frame Thickness 
(B) 

Aligned with wall 
thickness 
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4.3.2.4 Door Object 
(1) Timber Door 

 

Model View: PLAN 

 

Model View: ELEVATION 
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(1) Timber Door (Cont’d) 

 

Model View: 3D VIEW 
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(1) Timber Door (Cont’d) 
 

Object View: PARAMETER 
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(2) Metal Door 
 

Model View: PLAN 

 
 

Model View: ELEVATION 
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(2) Metal Door (Cont’d) 
 

Model View: 3D VIEW 
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(2) Metal Door (Cont’d) 
 

Object View: PARAMETER 

 

  



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 43 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date: Dec 2023 

 

(3) Sliding Folding Partition 
 

Model View: PLAN 

 

Model View: ELEVATION 
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(3) Sliding Folding Partition (Cont’d) 
 

Model View: 3D VIEW 
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(3) Sliding Folding Partition (Cont’d) 
 

Object View: PARAMETER 
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4.3.3 Quantity Take-off 
4.3.3.1 Door Schedule 

 

Step 1 

Create a new Door schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 
 
Sample of Door Schedule 
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4.3.3.1 Door Schedule (Cont’d) 
 

Step 2 

Schedule Properties and Setting 

 Fields  Sorting/Grouping 
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4.4 Windows and Louvres 
 
This section mainly focuses on the following windows and louvres: 
i. Windows 
ii. Louvres 
 

4.4.1 Basic Information 
4.4.1.1 Building Element to Model 

 
Modelling elements: 

Elements Object Category 

Work Description Manage/ Settings/ Materials 

Window Window 

 
4.4.1.2 Sequence of modelling 

 
The sequence of modelling: 

Create new object  (1) Window (e.g. Metric Window)  (2) Use the tools of Form panel to draw the 
window frame or glazing Add Parameters  Create wall in Project  Load into Project  Add window 

 (1) 

 (2) 

 Window/ Louvre is a wall host component; 
 Window/ Louvre in a curtain wall shall be created from curtain panel. 
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4.4.2 Modelling Approach 
4.4.2.1 Object Naming 

Details of naming convention shall refer to Section 4.9.2 of BIM Guide for Architectural Design issued by 
Architectural Branch, Architectural Services Department. 

Format: 
<Category> - <Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Object Name WDW-SGH-ADA-ALU-01 Descriptions 

Category WDW-SGH-ADA-ALU-01 A window, WDW is the short form of 
the Category type “Window” 

Functional Type WDW-SGH-ADA-ALU-01 A single hung window, SGH is the 
short form of the functional type 

“single hung window” 

Originator WDW-SGH-ADA-ALU-01 ADA for architectural discipline of 
ArchSD 

Descriptor 1 WDW-SGH-ADA-ALU-01 A window frame is made of 
aluminium (material).  

Descriptor 2 WDW-SGH-ADA-ALU-01 Type 1 of the single hung window. 

 
Functional Type Descriptions 

SGH Single Hung Window 

DBH Double Hung Window 

SLD Sliding Window 

FXD Fixed Window 

AWN Awning Window 

COW Composite Windows 

CWD Composite Windows and Doors 

LVR Louvre 

OTR Other 

 
4.4.2.2 Type Naming 

 

Format 

<Width>mm x <Height>mm (Input actual overall size of window/ louvre, reference to 4.4.2.3 Note 2)  

Window/ Louvre: 

Type Name Descriptions 
800mm x 500mm 800mm Window Width 

500mm Window Height 

1200mm x 300mm 1200mm Window Width 

300mm Window Height 
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4.4.2.3 Setting of creating a Window/ Louvre 
 
Window shall be modelled to its designed size with suitable parameters to allow computation of the size 
of structural opening. The following parameters shall be set in Window/ Louvre objects: 

Under Properties> Constraints 

Description Parameter Metal Window Metal Louvre 

Floor level Level (Built-in Parameter)  

Under Materials and Finishes 

Description Parameter Metal Window Metal Louvre 

Material of Window 
Frame 

Frame Exterior/ Interior 
Material# 

 

Material of Glass Glazing Type/  

Glass Panel Material# 

 

Material of Window Sash Sash Material#  

Material of Louvre Louvre Material#  

# The information inserted in the parameter Material is for rendering purpose only, please refer to 
Window details for the type of material. 

Under Dimension 

Description Parameter Metal Window Metal Louvre 

Structural opening width Width  

Structural opening height Height  

Window/ Louvre frame 
width 

Window Frame  

Under Identity Data 

Description Parameter Metal Window Metal Louvre 

Window/ Louvre type 
mark 

Type Mark 
(Built-in Parameter) 

 

Under General 

Description Parameter Metal Window Metal Louvre 

Number and type of 
Lights 

Number and type of Lights  

Window/ Louvre 
classification 

Window classification  

Window/ Louvre type 
mark 

Window/ Louvre mark   
(if Type Mark not used) 

 

Window/ Louvre size Window size  
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4.4.2.3 Setting of creating a Window/ Louvre (Cont’d) 
 
Note: 

1. Models for window frame, glass pane and louvre blades are for geometrical indication only, 
please refer Detailed Drawings for actual dimension. 

2. Window/ Louvre size calculation, reference to the window schedule: 

e.g. Window W1 = (Width – 25 x 2) x (Height – 25 x 2) = 2750 x 1750 

    
  

= Width 

Height 

Window W1 

Window W1 
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4.4.2.3 Setting of creating a Window/ Louvre (Cont’d) 
 

 

 

 

 

Window W1 

Window W1 
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4.4.2.4 Window/ Louvre Object 
(1) Window 

 

Model View: PLAN 

 
 

Model View: ELEVATION 
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(1) Window (Cont’d) 
 

Model View: 3D VIEW 
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(1) Window (Cont’d)  
 

Object View: PARAMETER 
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(2) Louvre 
 

Model View: PLAN 

 

Model View: ELEVATION 
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(2) Louvre (Cont’d) 
 

Model View: 3D VIEW 
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(2) Louvre (Cont’d) 
 

Object View: PARAMETER 
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4.4.3 Quantity Take-off 
4.4.3.1 Window Schedule 

- Number of Windows/ louvre/ access panel (if any) can be measured in Window Schedule under 
Window/ Wall Category. 

Step 1 

Create a new Windows schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 
 
Sample of Window Schedule 
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4.4.3.1 Window Schedule (Cont’d) 
 

Step 2 

Schedule Properties and Setting 
 

 Fields 

 
 Sorting/Grouping 
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4.5 Handrails and Balustrades 
 
4.5.1 Basic Information 
4.5.1.1 Building Element to Model 

 
Modelling elements: 

Elements Object Category 

Work Description Manage/ Settings/ Materials 

Railing Railing 

 
 

4.5.1.2 Sequence of modelling 
 
The sequence of modelling: 

Architecture tab  (1) Railing  (2) Choose the railing type in Properties  (3) Select Sketch on Path 
/ Place on Stair/Ramp  (4) Draw the path on plan  (5) Pick new host  (6) Click the   to confirm 

  

 Railing on sketch path; 
 Railing place on stair / ramp 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Example 1 
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4.5.1.2 Sequence of modelling (Cont’d) 
 
  

Example 2 
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4.5.2 Modelling Approach 
4.5.2.1 Type Naming 

Railing is a built-in name of the system object. 

Format: 
<Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Type Name HRL-ADA-GMS_900mm-01 Descriptions 
Functional Type HRL-ADA-GMS_900mm-01 A railing, RAL is the short form of 

the functional type “Railing” 

Originator HRL-ADA-GMS_900mm-01 ADA for architectural discipline of 
ArchSD 

Descriptor 1 HRL-ADA-GMS_900mm-01 A railing is made of “Galvanized 
Mild Steel” with 900mm height. 

GMS is the short form of the 
“Galvanized Mild Steel”.  

Descriptor 2 HRL-ADA-GMS_900mm-01 Type 1 of the handrail 

 
Functional Type Descriptions 

HRL Handrail 

BAL Baluster 

PNL Panel 

OTR Other 

 
Descriptor 1 Descriptions 

GMS Galvanized mild steel handrail 

CCR Concrete railing 

SST Stainless steel railing 
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4.5.2.2 Setting of creating a Railing 
Railing shall be modelled to its true size with parameters to allow full flexibility to retrieve the quantities. 

 

The following parameters shall be set in a Railing: 

a. Properties 

Under Constraint (a1) 

Parameter Remark 

Base Level/ Location Identify the base level/ location, e.g. input Staircase <number> 

Offset from Path Input + / - values, set the railing offset from the edge of treads, 
stringers, or paths on other hosts. 

Under Dimensions (a2) 

Parameter Remark 

Length Total length of the railing but not including any extension length, 
lateral offset in the intermediate connection, beginning and ends. 

 
  

(a1) 
 
 

(a2) 
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b. Edit Type > Type Properties 

 

Under Construction (b1) 

Parameter Remark 

Use Landing Height Adjustment Controls the height of railing at landings 

Landing Height Adjustment For balustrades only 

Tangent Joins Vertical/ Horizontal segments/ No connector/ Extend Rails to Meet 
Railing design and its length will be updated when option “Extend 
Rails to Meet” is selected. 

Under Top Rail (b2) 

Parameter Remark 

Type There are a number of parameters which can be adjusted to change 
the geometry and length of railing. These parameters are listed under 
the Type Parameters table: 

(b1) 
(b2) 

(b3) 
 
 
(b4) 
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c. Top Rail/ Handrail 1/ Handrail 2 > Type >Type Parameters 

Under Construction (c1) 

Parameter Remark 

Hand Clearance The distance from the outside edge of the handrail to the wall, post, 
or column 

Height The height of the top of the handrail from the floor, tread, stringer, 
ramp, or other host surface. 

Profile Select the shape or Create the custom profile 

Transitions None / Gooseneck / Simple 

Under Extension (Beginning/Bottom) (c2) 

Parameter Remark 

Extension Style None / Wall / Floor / Post 

Length The length of the extension. The extension length should be adjusted 
in the Railing Schedule. 

Plug Tread Depth Option to add one tread depth to the length of the extension. 

Under Extension (End/Top) (c3) 

Parameter Remark 

Extension Style None / Wall / Floor / Post 

Length The length of the extension. The extension length should be adjusted 
in the Railing Schedule. 

(c1) 
 
 
 
 
 
(c2) 
 
 
(c3) 
 
 
(c4) 
 
 
(c5) 
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Under Terminations (c4) 

Parameter Remark 

Beginning/Bottom Termination Set the type of termination 

End/Top Termination Set the type of termination 

Under Supports (c5) 

Parameter Remark 

Family Select the type of the supports 

Layout None/ Fixed Distance/ Align With Posts/ Fixed Number/ Maximum 
Spacing/ Minimum Spacing 

Spacing Set the center-to-center distance of the supports 

Justification Begin/ Center/ End 
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4.5.2.3 Railing Object 
(1) Handrail 

Section View 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3D View 
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Object View: PARAMETER 
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Object View: PARAMETER 
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(2) Baluster 

Section View 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

3D View 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

 

Object View: PARAMETER 
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Object View: PARAMETER - Rail Structure (Non-Continuous) 

 

Object View: PARAMETER - Baluster Placement   
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4.5.3 Quantity Take-off 
4.5.3.1 Railing Schedule 

 
Railing category is not available for detail quantity take-off, regular schedule can be used to extract the 
length of rails and number of supports.  However, quantities of other railing members including balusters, 
posts, brackets and plates cannot be retrievable due to software limitation. 
 

a. Railings placed horizontally can be measured on plan.  
b. Length will be updated automatically when parameter of railing is changed. However, it is found 

that definition of length provided by the system may not be fully in line with actual measurement.  
i) For example, two handrails highlighted in red, both are 5000mm long when measured on 

plan.  

ii) The above handrail on right is horizontal, its length is 5000mm.  
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iii) The above handrail on left is mounted to a staircase, its length reported by the program as 
highlighted in red is 6182.5mm, which is fully in line with direct measurement on elevation 

iv) Definition of length can be reflected when the railing is changed in 2D Section View.* 
  View > (1) Section – to create a custom 2D Section View 
  (2) Right click the mouse over the Section Arrow > (3) Go to View 
  (4) 2D Section View will be opened  
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v) Use the measure tools to check the actual length. 
 Select the railing > (1) Modify Railings > (2) Measure 

 
  

Length = 2623.9 

Measured Length = 3223.2 = 2623.6 + (Extension 304.1 + 295.5) 
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* Alternative measurement tool for railing in 3D view is also available in software 2023 version. 

 
 

Step 1 

Create a new (1) Railing / (2) Supports schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ 
Material Take-off. 
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Sample of Railing Schedule * 

 
 
Notes:  
 
i) The Length does not include any extension length and lateral offset in the intermediate connection, 

beginning and ends. Officers should check and adjust the quantities in the 2D Section. See Figure 1. 
ii) Supports are deemed to be included as the method of 

measurement adopted here.  
 
* Base level/ Location should be input by the Modeller. 

 
 
Step 2 

Schedule Properties and Setting 

 Fields 

 

  

 

  

Modeller 
should input 
the base 
level (if 
any). 

Not 
included 

Figure 1 
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4.6 Ladders and Stairs 
 
This section mainly focuses on the following: 
i. Cat Ladders 
ii. Metal Stairs 
iii. Suspended Walkways 
iv. Metal Platforms 

 
4.6.1 Basic Information 
4.6.1.1 Building Element to Model 

 
Modelling elements: 

Elements Object Category 

Work Description Manage/ Settings/ Materials 

Cat Ladders Specialty Equipment 

Metal Stairs Stairs 

Suspended Walkways Railings 

Metal Platforms Generic Model 

 
4.6.2 Modelling Approach 
4.6.2.1 Cat Ladder 
4.6.2.1.1 Object Naming 

Cat ladder should be a loadable object and can be created with Specialty Equipment wall based 
Template. 

Object Format: 
<Category> - <Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Object Name SPQ-LAD-ADA-CatLadder-01 Descriptions 
Category SPQ-LAD-ADA-CatLadder-01 SPQ is the short form of the Category 

type “Specially Equipment” 

Functional Type SPQ-LAD-ADA-CatLadder-01 LAD is the short form of the functional 
type “Ladder” 

Originator SPQ-LAD-ADA-CatLadder-01 ADA for architectural discipline of 
ArchSD 

Descriptor 1 SPQ-LAD-ADA-CatLadder-01 A descriptive text, i.e. Cat Ladder 

Descriptor 2 SPQ-LAD-ADA-CatLadder-01 Type 1 of the cat ladder 
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4.6.2.1.2 Setting of creating a Cat Ladder 

Under Properties> Identity Data 

Parameter Remark 

Fixing method Input the cat ladder fixing method 

Location Input the cat ladder location 

Overall size Input the cat ladder overall size 

Mark Input the cat ladder mark 

 
4.6.2.1.3 Cat Ladder Object 

(1) Cat Ladder with safety hoop and lockable plate 

Elevation View 
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Properties, Plan View and 3D View 

 

 

 

Object Types 
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(2) Cat ladder with safety hoop 

Elevation View 
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Plan View 

 

3D View 
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Object View: PARAMETER 
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(3) Cat Ladder 

Elevation View 

 
 



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 86 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date: Dec 2023 

 

Properties and Object Types 

 

 
 
 
 
 
 
 
 
 
 

3D View and Plan View 
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4.6.2.2 Metal Stair 
4.6.2.2.1 Type Naming 
 

Metal stair should be based on the stairs template, a system object type for assembled stair is created 
by sketching the alignment of the stair from the base level (stair base) to top level (stair top). The relevant 
dimensions can be extracted from the parameters such as the actual number of riser, actual riser height, 
actual tread depth, etc. 
 
Type Format: 
<Function Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Type Name STS-ADA-Maint_1360mmW-__ Descriptions 

Function Type STS-ADA-Maint_1360mmW-__ STS is the short form of the function type 
“Steel Stair” 

Originator STS-ADA-Maint_1360mmW-__ ADA for architectural discipline of ArchSD 

Descriptor 1 STS-ADA-Maint_1360mmW-__ A descriptive text, i.e. Maintenance Stair 
with overall 1360mm wide 

Descriptor 2 STS-ADA-Maint_1360mmW-__ 2-digit sequential number to distinguish 
different types, if Descriptor 2 is blank, two 

underscores (__) should be used. 

 
4.6.2.2.2 Setting of creating Metal Stair 

Under Identity Data 

Parameter Remark 

Location Input the metal stair location 

Mark Input the metal stair mark 

Type Input the metal stair type 

  



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 88 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date: Dec 2023 

 

4.6.2.2.3 Metal Stair Object 
(1) Metal stair with 1 flight (suspended walkway in both end) 

Section View 

 

Properties, Plan View and 3D View 
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Types Properties 
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(2) Metal stair with 2 flights and 1 landing (suspended walkway in both end) 

Section View and Plan View 

 
 

Properties and 3D View 
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4.6.2.3 Suspended Walkway 
4.6.2.3.1 Object Naming 
 

Suspended Walkway should be based on the generic model template, a loadable object type for 
suspended walkway is created by placing the object to desired location. 
 
Object Format: 
<Category> - <Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Object Name GMD-MTL-ADA-SUSPD_Walkway-01 Descriptions 

Category GMD-MTL-ADA-SUSPD_Walkway-01 GMD is the short form of the 
Category type “Generic Models” 

Functional Type GMD-MTL-ADA-SUSPD_Walkway-01 MTL is the short form of the functional 
type “Metal” 

Originator GMD-MTL-ADA-SUSPD_Walkway-01 ADA for architectural discipline of 
ArchSD 

Descriptor 1 GMD-MTL-ADA-SUSPD_Walkway-01 A descriptive text, i.e. Suspended 
Walkway 

Descriptor 2 GMD-MTL-ADA-SUSPD_Walkway-01 Type 1 of the suspended walkway 

 
4.6.2.3.2 Setting of creating a Suspended Walkway 

Under Identity Data 

Parameter Remark 

Location Input the suspended walkway location 

Mark Input the suspended walkway mark 
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4.6.2.3.3 Suspended Walkway Object 
 

Elevation View 

 

Properties and Section View 

 

3D View 
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Object Types 
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4.6.2.4 Metal Platform 
4.6.2.4.1 Object Naming 
 

Metal Platform should be based on the generic model template, a loadable object type for platform is 
created by placing the object to desired location. 
 
Object Format: 
<Category> - <Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Object Name GMD-MTL-ADA-Platform_LShape-01 Descriptions 

Category GMD-MTL-ADA-Platform_LShape-01 GMD is the short form of the 
Category type “Generic Models” 

Functional Type GMD-MTL-ADA-Platform_LShape-01 MTL is the short form of the functional 
type “Metal” 

Originator GMD-MTL-ADA-Platform_LShape-01 ADA for architectural discipline of 
ArchSD 

Descriptor 1 GMD-MTL-ADA-Platform_LShape-01 A descriptive text,  
i.e. Platform in L-shape 

Descriptor 2 GMD-MTL-ADA-Platform_LShape-01 Type 1 of the metal platform 

 
4.6.2.4.2 Setting of creating a Metal Platform 

 

Under Identity Data 

Parameter Remark 

Location Input the metal platform location 

Fixing method Input the metal platform fixing method 

Mark Input the metal platform mark 

Overall size Input the metal platform overall size 
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4.6.2.4.3 Platform Object 

(1) Platform in L-Shaped on plan 

Elevation View 

 

 

Plan View 
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3D View 

 
Object Types 

 



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 97 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date: Dec 2023 

 

4.6.3 Quantity Take-off 
4.6.3.1 Cat Ladder Schedule 

Step 1 

Create a new Specialty Equipment schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material 

Take-off. 

 

Sample of Cat Ladder Schedule 

 

Step 2 

Schedule Properties and Setting 

 Fields 

 

 

Note: 

Cat Ladders are measured in number including stringers, rungs, guardrails, lockable plates, fixing 

brackets and other necessary components. 
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4.6.3.2 Metal Stair Schedule 

Step 1 

Create a new Stairs schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 

Sample of Metal Stair Schedule 

 

 

Step 2 

Schedule Properties and Setting 

 Fields 

 

 

Notes: 

i) Metal stairs are measured in number including all component parts of stairs including treads, risers, 

stringers, landing platforms and supporting beams and columns. 

ii) Handrails and balustrades are measured separately from metal stairs. 
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4.6.3.3 Suspended Walkway Schedule 

Step 1 

Create a new Railings schedule for suspended walkways, refer to Part 7 Techniques for QTO - 7.4 

Schedule/ Material Take-off. 

 

Sample of Suspended Walkway Schedule 

 

Step 2 

Schedule Properties and Setting 

 Fields 

 

 

Notes: 

i) Suspended Walkway are measured in meter run including all component parts of walkways including 

rails, toeboards, pans and all necessary accessories. 

ii) Identify any fire resistant coating (if required). 
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4.6.3.4 Metal Platform Schedule 

Step 1 

Create a new Generic Models schedule for platform, refer to Part 7 Techniques for QTO - 7.4 Schedule/ 

Material Take-off. 

 

Sample of Metal Platform Schedule 

 

Step 2 

Schedule Properties and Setting 

 Fields 

 

 

Notes: 

i) Platform are measured in meter square including all component parts of platform including rails, 

toeboards, pans and all necessary accessories. 

ii) Identify any fire resistant coating (if required). 
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4.7 Curtain Wall and Glass Wall 
 

This section mainly focuses on curtain wall and glass wall. 

 

4.7.1 Basic Information 

4.7.1.1 Building Element to Model 

 

Modelling elements: 

Elements Object Category 

Work Description Manage/ Settings/ Materials 

Curtain Wall/ Glass Wall/ Window Wall Curtain Wall: Wall: Architectural 

Curtain Systems Curtain Systems 

 

4.7.1.2 Sequence of modelling 

 

The sequence of modelling: 

Architecture tab  (1) Wall: Architectural  (2) Select a curtain wall type  (3) Create a curtain wall or 

glass wall by drawing line, picking lines or picking faces. An example is as follows: 
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4.7.2 Modelling Approach 

4.7.2.1 Type Naming 

Curtain wall is a system object of wall and the default Type includes: curtain wall, exterior glazing and storefront. 

Curtain System can be created by select a mass face. 

Format: 

<Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Type Name CUW-ADA-1200x600mm-01 Descriptions 

Functional Type CUW-ADA-1200x600mm-01 A curtain wall, CUW is the short form of the 

functional type “curtain wall” 

Originator CUW-ADA-1200x600mm-01 ADA for architectural discipline of ArchSD 

Descriptor 1 CUW-ADA-1200x600mm-01 Curtain wall typical vertical x horizontal grid 

distance 

Descriptor 2 CUW-ADA-1200x600mm-01 Type 1 of the curtain wall 

 

Functional Type Descriptions 

CUW Curtain Wall 

GLW Glass Wall 

WDW Window Wall 

LVW Louvre Wall 
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4.7.2.2 Setting of creating Curtain Wall/ Glass Wall 

 

Curtain Wall/ Glass Wall shall be modelled to its designed size with suitable parameters to allow 

computation and categorisation of the wall area. The following parameters shall be set: 

Under Properties> Constraints 

Parameter Remark 

Base Constraint Input the value for base level 

Top Constraint Input the value for top level 

 

Under Properties> Dimensions 

Parameter Remark 

Area Built-in parameter 

 

Under Type Properties> Identity Data 

Parameter Remark 

Type Mark  Input the Type Mark for categorisation 

 

The measurement of the plane area for curtain wall/ glass wall is deemed to include all framing members 

and vision panels at perimeters. Where different types of curtain walling are included in the same plane, 

the measurement of the plane area for each type is measured from center line of the mullion and transom 

or vision panel at the junction as appropriate. 
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4.7.2.3 Curtain Wall/ Glass Wall Object 

 

Model View: PLAN 

 

 

Model View: ELEVATION 
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Model View: 3D VIEW 
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Object View: PARAMETER 
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4.7.3 Quantity Take-off 

4.7.3.1 Curtain Wall/ Glass Wall Schedule 

-Area of curtain wall/ glass wall can be measured in the Wall Schedule under Walls category. 

 

Step 1 

Create a new Walls Schedule, refer to Part 7 Techniques for QTO – 7.4 Schedule/ Material Take-off. Filter 

can be used for grouping of various types of curtain wall based on the Type Mark in the Wall Schedule. 

 

Sample of Wall Schedule for curtain wall: 
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4.7.3.1 Curtain Wall/ Glass Wall Schedule (Cont’d) 

 

Step 2 

Schedule Properties and Setting 

 Fields 

 
 Sorting/Grouping 
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4.8 Claddings 
 

This section mainly focuses on wall cladding. 

 

4.8.1 Basic Information 

4.8.1.1 Building Element to Model 

 

Modelling elements: 

Elements Object Category 

Work Description Manage/ Settings/ Materials 

Wall Cladding Wall : Architectural 

 

4.8.1.2 Sequence of modelling 

 

The sequence of modelling: 

Architecture tab  (1) Wall: Architectural  (2) Select a wall type for cladding  (3) Create cladding by 

drawing line, picking lines or picking faces. An example is as follows: 
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4.8.2 Modelling Approach 

4.8.2.1 Type Naming 

Format: 

<Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Type Name CLD-ADA-ALU_3mm-01 Descriptions 

Functional Type CLD-ADA-ALU_3mm-01 A wall cladding, CLD is the short form of 

the functional type “cladding” 

Originator CLD-ADA-ALU_3mm-01 ADA for architectural discipline of ArchSD 

Descriptor 1 CLD-ADA-ALU_3mm-01 An aluminium wall cladding with 3mm 

thick panel. 

Descriptor 2 CLD-ADA-ALU_3mm-01 Type 1 of the aluminium wall cladding. 

 

4.8.2.2 Setting of creating Cladding 

 

Cladding shall be modelled to its designed size with suitable parameters to allow computation and 

categorisation of the wall area. The following parameters shall be set: 

 

Under Properties> Constraints 

Parameter Remark 

Base Constraint Input the value for base level 

Top Constraint Input the value for top level 

 

Under Properties> Dimensions 

Parameter Remark 

Length Built-in parameter 

Area Built-in parameter 

 

Under Type Properties> Identity Data 

Parameter Remark 

Type Mark  Input the Type Mark for categorisation 

 
The measurement of the plane area for wall cladding is deemed to include the exposed face and boundary 

works at perimeters. Where different types of wall cladding are included in the same plane, each type of 

wall claddings is measured separately. 
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4.8.2.3 Cladding Object 

 

Model View: PLAN 

 

 

Model View: ELEVATION 
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Model View: 3D VIEW 

 

 

 

  

Aluminium Wall 

Cladding 
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Object View: PARAMETER 
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4.8.3 Quantity Take-off 

4.8.3.1 Wall Cladding 

 

-Area of wall cladding can be measured in the Wall Schedule under Walls category. 

 

Step 1 

Create a new Wall Schedule, refer to Part 7 Techniques for QTO – 7.4 Schedule/ Material Take-off. Filter 

can be used for grouping of various types of cladding based on the Type Mark in the Wall Schedule. 

 

Sample of Wall Schedule for Wall Cladding: 
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4.8.3.1 Curtain Wall/ Glass Wall Schedule (Cont’d) 

 

Step 2 

Schedule Properties and Setting 

 Fields 

 
 Sorting/Grouping 
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4.9 Furniture and Fittings 
4.9.1 Basic Information 

4.9.1.1 Building Element to Model 

 

Modelling elements: 

Elements Object Category 

Work Description Manage/ Settings/ Materials 

Furniture  Generic Models: Furniture 

Casework Generic Models: Casework 

 

4.9.1.2 Sequence of modelling 

 

The sequence of modelling: 

Architecture tab  (1) Component  (2) Place a Component  (3) Load Object  (4) Choose the 

type for Furniture (Furniture / Casework )  (5) Click open  (6) Place the Furniture 
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4.9.2 Modelling Approach 

4.9.2.1 Object Naming 

Furniture can be created with generic models template and categorized in Furniture/ Furniture Systems. 

Format: 

<Category> - <Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Object Name FUR-STG-ADA-Cupb_w_3Drawers-01 Descriptions 

Category FUR-STG-ADA-Cupb_w_3Drawers-01 A furniture, FUR is the short form of the 

Category type “Furniture” 

Functional Type FUR-STG-ADA-Cupb_w_3Drawers-01 STG is the short form of the functional 

type “Storage” 

Originator FUR-STG-ADA-Cupb_w_3Drawers-01 ADA for architectural discipline of 

ArchSD 

Descriptor 1 FUR-STG-ADA-Cupb_w_3Drawers-01 This text describes the type of furniture. 

The type of storage is cupboard with 3 

drawers 

Descriptor 2 FUR-STG-ADA-Cupb_w_3Drawers-01 Type 1 of the cupboard 

 

Category Descriptions 

Example 1 
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FUR Furniture 

FNY Furniture Systems 

CWK Casework 

 

Functional Type Descriptions Descriptor 1 

STG Storage Cabinet / Cab 

Cupboard / Cupb 

Locker 

Shelf 

FillUp 

withoutDR 

w_NrDrawer / w_NrDWR 

DSK Desk Classroom / Classrm 

Office 

w_Drawer 

LShape 

SIT Seating OfficeChair 

Stool 

TaskChair 

Bench 

ConferenceChair / 

CONFChair 

w_Armrest 

w_ChaiseLongue 

TBL Table Conference / CONF 

Dinning 

Laboratory 

Rectangular 

Round 

w_Chairs 

CBN Cabinet Cabinet/ Cab 

Cupboard / Cupb 

FillUp 

withoutDR 

w_Nr_Drawer / w_Nr_DWR 

CTT Counter Top CounterTop w_Sink 

w_Nr_Sink 

OTR Other - - 

 

  



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 119 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date:  Dec 2023 

 

4.9.2.2 Setting of creating a Furniture 

Furniture shall be modelled to its designed size with parameters to allow full flexibility to retrieve the 

quantities.  

The following parameters shall be set in a Furniture: 

        

a. Properties 

Under Constraint (a1) 

Parameter Remark 

Base Level/ Location Identify the base level/ location, e.g. input Room number 

Under Identity Data (a2) 

Parameter Remark 

Mark Identify the type of Furniture. 

 

  

(b1) 

(b2) 

(a1) 

(a2) 
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b. Edit Type > Type Properties 

Under Construction (b1) 

Parameter Remark 

Depth Overall depth for the Furniture  

Height Overall height for the Furniture 

Width Overall width for the Furniture 

Under Identity Data (b2) 

Parameter Remark 

Description Identify the main material for Furniture.(Wood / Metal) 
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4.9.3 Quantity Take-off 

4.9.3.1 Furniture Schedule 

Step 1 

Create a new Furniture schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 

 

Sample of Furniture Schedule 

 

 

Step 2 

 Schedule Properties and Setting 

   Fields

 

 Sorting/Grouping
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4.10 Finishing  
 
This section mainly focuses on the surface finishes. 

i. Floor 

ii. Wall 

iii. Ceiling 

 

4.10.1 Basic Information 

4.10.1.1 Building Element to Model 

 

Modelling elements 

Elements Object Category 

Floor Floor Architectural 

Wall Wall Architectural 

Ceiling Ceiling 

 

4.10.1.2 Sequence of modelling 

 

The Sequence of modelling: 

Step 1: Room 

Step 2: Floor/ Wall/ Ceiling Finishes layer if Room is not applicable. 

Step 3: Paint 

 

Room; Paint and Finishes layers should be modelled in BIM models for LOIN300 or above, but not 

limited to: 

 Room for each room 

 Finishing schedule 

 Finishing mark for each location   

 Finishes layer for screeds, tiles, carpet, waterproofing, tactile, painting, suspended ceiling etc. 
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4.10.2 Modelling Approach 

4.10.2.1 Type Naming 

Format: 

<Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Type Name Descriptions 

Floor Wall Ceiling 

Functional Type AFF – Floor finishes 

 

AWF – Wall finishes CEL - Ceiling 

Originator ADA – for architectural discipline of ArchSD 

 

Descriptor 1 Tile – Floor Tile 

WD – Wood 

PT – Paint 

ST – Stone 

Tile 

Render 

Paint 

Metal 

Timber 

Gypsum 

_50mm 

_300x300mm 

 

_10mm _600x600mm 

_600x1200mm 

Descriptor 2 

(type number ; 

2-digit sequential number) 

01 01 01 

 

4.10.2.2 Modelling 

 

Room 

Architecture > Room (RM) 

 



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 124 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date:  Dec 2023 

 

 

a. Modeller should input the following essential room parameter.   

b. (a) Upper Limit, Limit Offset, Base Offset, (b) Name, (c) Finishing marks 

c. Unbounded Height, Area and Perimeter will be generated. 

  
 

  

(a) 

(b

(c) 
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Finishes layers 

Architecture > (1) Floor: Architectural/ (2) Wall: Architectural/ (3) Ceiling 

 
 

a. Floor finishes should be modelled on the architectural floor slab.   

b. Finishes boundary of each room should be defined one by one. 

c. Area under the door leafs should be bounded for the same materials.  
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d. Modeller should insert the room name in the new shared/ available parameter (e.g. Comments) for 

location identification. 
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e. Each layer of finishes should be inserted under the Structure parameter. 

 
 

f. Wall finishes should be modelled on the floor finishes and extend 100mm (minimum) above the 

bottom level of suspended ceiling. General settings of wall finishes are similar to the floor finishes. 

g. Overlapping between finishes should be avoided. 

h. General finishes under soffits should be included in the ceiling finishing mark. 

i.  Suspended ceiling should be built in a separate work set for better coordination. 
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4.10.3 Quantity Take-off 

 

Surface finishes can be measured by i) Material Takeoff Schedule, ii) Room Schedule and iii) Paint 

function.  However, adjustment of finishes to suit measurement rules are required due to limitation of the 

BIM software. 
 
Adjustment of finishes for  

 Dividing strips between different finishing materials 

 Finishes under the door leafs 

 Window sills 

 Opening adjustments 

 Sides of beams and columns 

 Height of soffit for finishes 

 Depth of suspension for suspended ceilings 

 Intersection between elements 

 

4.10.3.1 Material Takeoff Schedule 

 

Measure the modelled finishes layer direct in the BIM model. 

View > Schedules > Material Takeoff 

 
Create a new Floors/ Walls/ Ceilings Material Takeoff Schedule 

Select the required fields as below 
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Material Takeoff Schedule 

 

Notes: 

i)  If a separate shared parameter for location should be added into the schedule. 

ii) Finishing adjustment is required for openings. 

iii) Different layer of finishes should be billed. 
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4.10.3.2 Rooms 

 

Measure the overall floor/ceiling area and perimeter by Room Schedule. 

Limitation of Room:  

 Only applicable to the room bounded by the model elements. 

 Room is visible in plan and section only but not in 3D view. 

 Openings will not be deducted in the total area and perimeter. 

 

View the Rooms in the plan/ section 

 “” the Rooms under the Visibility/Graphic (VV) to make the Rooms visible 

 

 

 Plan Section 
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Room Schedule 

Analyze > Schedule/Quantities 

 

a. Create a new Room Schedule 

b. Select the required fields as below 

 

 
Notes:  

i)  Unbounded height = Limit Offset – Base Offset 

ii) When you selected a room, you may click the “section box” to isolate the room in 3D view. 

iii) Suggest to insert the door mark/ window mark in the schedule for finishing adjustment. 
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4.10.3.3 Paint 

 

For irregular shape and finishing adjustments 

Use of Paint function is recommended. It could supplement the limitation of Finishes Layer and Room. 

Modify > Geometry > Paint (PT) 

 
 

Select/Create the required materials to apply to elements in 3D view
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Material Browser 

 

Applied the Paint by point to the elements directly. 

 
You may remove the Paint easily. 

  
Notes: 

i)  QTO in Paint is similar to the Material Takeoff, please refer to 4.10.3.1. 

ii) Suggest to add a mark to a shared parameter (e.g. Comments) to identify the elements to be 

painted. 
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4.11 Landscaping Works 
 

This section mainly focuses on the following items: 

i. Trees (Retained / Transplanting) 

ii. Trees (Proposed) 

iii. Shrubs 

iv. Soil Area 

 

4.11.1 Basic Information 

4.11.1.1 Building Elements to Model 
 
Modelling elements: 

Elements Object Category 

Tree Planting 

Shrubs / Groundcovers / Climbers / Turf / 

Plants without geometry 
Floor 

Soil Topo-surface 

 

4.11.1.2 Level of Information Need 

 

Items LOD-G LOD-I 

Tree LOD-G 200 LOD-I 300, Including approximate location, Tree name, 

height, spread 

Shrubs LOD-G 100 LOD-I 300, Including Shrubs name, area, Total No. 

Soil LOD-G 100 LOD-I 100, Including Soil top level, Soil depth 
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4.11.2 Modelling Approach 

4.11.2.1 Trees 
 
Object / Type Naming 

Format: 

<Category> - <Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Object Name PLT-TRE-ADA-NewPlant-01 Descriptions 

Category PLT-TRE-ADA-NewPlant-01 A plant, PLT is the short form of the 

Category type “Planting” 

Functional Type PLT-TRE-ADA-NewPlant-01 TRE is the short form of the functional 

type “tree” 

Originator PLT-TRE-ADA-NewPlant-01 ADA for architectural discipline of 

ArchSD 

Descriptor 1 PLT-TRE-ADA-NewPlant-01 This text describes the type of tree. 

Descriptor 2 PLT-TRE-ADA-NewPlant-01 Type 1 of the new planting tree 

 

PLT-TRE-ADA-NewPlant-01 : BV 

 

 

 

Type of Tree Type Naming Description 

New Planting Tree BV Tree Code 

Transplanting / Retained Tree T950 Livistona chinensis Existing Tree Marks and Tree Name 

 

  

Object Name Type Name 
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Step 1 

Create a new object of tree using Planting as a template. 

 

Step 2 

Create Shared Parameters as below; refer to Part 7 Techniques for QTO - 7.2 Shared Parameters. 

 

Create a Landscape Parameters.txt file, add necessary parameters under the Trees Information group 

and click OK to Progress. 

 

 

Step 3 

Create the Tree model. 

The spread can be created by Revolve and the trunk can be created by Extrusion. 
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Step 4 

Create a new parameter Spread Radius as below picture. 

Select Shared parameter and click the Select.. under the Parameter Type. 

Select Instance Parameter. 

 

 

Step 5 

Select the trunk 

In properties, select Extrusion End as below picture. 
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Under Associate Family Parameter, create a new shared parameter Trunk Height. 

Select Instance Parameter. 

 

 

Step 6 

Create a new shared parameter Tree Height as below picture. 
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Step 7 

1. Create a new parameter Tree Crown Spread, set Formula = Spread Radius * 2 

2. In parameter Trunk Height, set Formula = Tree Height - Spread Radius * 2 

3. Tick Lock for parameter Tree Height, Tree Crown Spread, Spread Radius and Truck Height 

4. Click  for create New Type and change the Type Name as per Naming Convention stipulated 

previously.  

 
 

Step 8 

After load into project, mark the existing tree no. into Mark. 
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Step 9 

Determine the tree status in the Comments box. 
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4.11.2.2 Shrubs 

 

Type Naming 

Format: 

<Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2> 

Type Name SHU-ADA-ShrubAod-__ Descriptions 

Functional Type SHU-ADA-ShrubAod-__ SHU is the short form of the functional type 

“Shrub” 

Originator SHU-ADA-ShrubAod-__ ADA for architectural discipline of ArchSD 

Descriptor 1 SHU-ADA-ShrubAod-__ This text describes the type of shrub. 

Descriptor 2 SHU-ADA-ShrubAod-__ 2-digit sequential number to distinguish 

different types, if Descriptor 2 is blank, two 

underscores (__) should be used 

 

Floor : SHU-ADA-ShrubAod-__ 

 

 

 

Descriptor 1 Description 

Shrubxxx 

 Plant Type + Plant Reference Name 

Groundcoverxxx 

Climberxxx 

OrnamentalGrassxxx 

Bambooxxx 

Turfxxx 

 

Step 1 

Use Floor as the shrub area 

 
1. Floor Type Name refer to Landscape drawings (e.g.SHU-ADA-ShrubAod-__) 

2. Set the Thickness = Depth 

3. Set the Material same as Type Name 

System Object Type Name 
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4. Create the floor refer to Landscape Drawings 

 

 

Step 2 

Create a new Shared Parameter  

Create a Landscape Parameters.txt file 

Add all necessary parameters under the Shrubs group (see the images) 
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Step 3 

Create a new Project Parameter 

 

Click Add and add all shared parameter that you have created before into Floor and set into the group 

of Identity Data. 

 

 

Step 4 

Project parameters are added under the properties and input information (Botanical name, Chinese 

Name, Height, Spacing and Spread) for every plant area. 

 

 

 

 

 

 

 

 

 

 

 

 

 

# The same modelling method can be applied for groundcover, climbers, etc. 
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4.11.2.3 Soil 

 

Step 1 

Use Toposurface to create the soil area. 

 
 

Step 2 

Set the elevation of each point.  
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Step 3 

Select the toposurface. 

Enter the soil depth in Comments 
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4.11.3 Quantity Take-off 

4.11.3.1 Trees Schedule (Retained/Transplanting) 

 

Step 1 

Create a new Planting schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 

 

Sample of Tree Schedule (Retained) 

  

 

Step 2 

Schedule Properties and Setting 

 Fields  Filter 
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4.11.3.1 Trees Schedule (Retained/Transplanting) (Cont’d) 

 

 Sorting/Grouping  Formatting - Count 
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4.11.3.2 Trees Schedule 

 

Step 1 

Create a new Planting schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off.  

 

Sample of Tree Schedule (Proposed) 

 

 

Step 2 

Schedule Properties and Setting 

 Fields  Filter 
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4.11.3.2 Trees Schedule (Cont’d) 

 

 Sorting/Grouping  Formatting - Count 

  
 

Step 3 

In Sorting/Grouping, untick Itemize every instance to show the summary table. 
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4.11.3.3 Shrubs Schedule 

 

Step 1 

Create a new Floor schedule to report Shrub information, refer to Part 7 Techniques for QTO - 7.4 

Schedule/ Material Take-off. Rename the schedule as Shrubs Schedule and click OK  
 

Sample of Shrubs Schedule 

 
 

Step 2 

Schedule Properties and Setting 

 Fields  Calculated Value - Quantity 

 
 

 

 Sorting/Grouping  Formatting - Quantity 
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4.11.3.4 Soil Area Schedule 
 
Step 1 

Create a new Topography schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-

off.  
 
Sample of Soil Schedule 

 

 

Step 2 

Schedule Properties and Setting 

 Fields  Sorting/Grouping 

  
  

Calculate Total 
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4.11.3.4 Soil Area Schedule (Cont’d) 

 

 Formatting - Comments  Formatting – Surface Area 
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5. Detailed Modelling Guidelines – Structural Engineering 
and Site Formation 

 
5.1 Site Formation (Applicable for project with toposurface model provided) 

 
This section mainly focuses on the Site Formation QTO (by taking retaining wall for demonstration) of the 
following items: 
i. RC Wall 
ii. RC Foundation 
iii. Blinding (to be input by QS) 
iv. Formwork (to be input by QS) 
v. Movement Joint (to be input by QS) 
vi. Excavation (Applicable for project with toposurface model provided) 
 

5.1.1 Basic Information 
5.1.1.1 Building Elements to Model 

Modelling elements: 

Elements Object Category 

Retaining Wall – Wall Structure/ Structure/ Wall 

Retaining Wall – Foundation Structure/ Foundation/ Slab 
Structure/ Foundation/ Isolated 
Structure/ Foundation/ Wall 

Site Terrain 
1. Massing & Site/ Model Site/ Toposurface 

2. Massing & Site/ Model Site/ Building Pad 

 
5.1.1.2 Sequence of modelling 

 
The sequence of modelling: 

Site Terrain (Toposurface) > Retaining Wall – Wall > Retaining Wall - Foundation > 
Excavation Works (Building Pad) 
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5.1.1.3 Sample of Retaining Wall 
 

1. Retaining Wall 
 
Plan View 

 
Section View 

 
 

3D View 
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5.1.2 Modelling Approach 
5.1.2.1 Site Terrain - Toposurface 
5.1.2.1.1 Application 
 

Create a new Toposurface 

Step 1 

Go to the Massing & Site Tab > Model Site panel > Toposurface 

 
 
Step 2 

Two method to create a new Toposurface: 
By Place Point 

 
 
By Import drawing 

 

 
 
Step 3 

Click “Tick” to finish.  
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5.1.2.2 Retaining Wall – Wall 
5.1.2.2.1 Application 
 

Placing wall 

Step 1 

Go to the Structure Tab > Build Panel > Wall 

 
 
Step 2 

Select the wall type in the properties window 

 
 

Step 3 

Draw the wall on the activated Floor Plan View or 3D View 
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Step 4 

Select the wall and change the wall height in the properties window 
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Create Wall Type 

Step 1 

Select the wall > Click the Edit Type in the Properties window 

 
 

Step 2 

Duplicate the existing type of wall > Type the Wall name 

 
 
Step 3 

Edit the Wall Structure and type the wall thickness in the Thickness field 

 
 
Step 4 

Click ok to finish 
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5.1.2.2.2 Properties 
 

The major properties in Schedule: 
 Remark 
i) Naming 

Properties > Change Type Panel 
(1) Object Name e.g. Basic Wall Figure 1 

ii) Parameter Input (By Modeller) 
Properties > Identity Data 
(2) Mark e.g. RW-5 Retaining Wall Mark; Figure 1 
Properties > Other 
(3) Concrete Grade e.g. Grade 35/20 Figure 1 
(4) QS Curved element e.g. No Figure 1 

iii) Parameter Input (By QS) 
Properties > Other   
(5) Wall Type e.g. Retaining Wall Figure 1 
(6) Element Code e.g. XWRS Sub-Element Code; Figure 1 

iv) Material/ Thickness 
Properties > Edit Type > Construction > Structure 
(7) Material e.g. Concrete Figure 2 
(8) Width e.g. 250 Wall Thickness; Figure 2; 

The Wall thickness can be 
found at the Type Name, see 
Figure 1 
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Figure 1 Wall Properties 

 
Figure 2 Wall Type Properties 

(8) 

(8) 

(3) 
(5) 
(6) 

(2) 

(1) 

(4) 
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5.1.2.3 Retaining Wall – Foundation 
5.1.2.3.1 Application 

 
Create a new foundation slab for retaining wall – foundation 

 By Structure - Foundation - Slab 

 By Structure - Foundation - Isolated 

 By Structure - Foundation - Wall 

 

By Structure - Foundation - Slab 

Step 1 

Go to the Structure Tab > Foundation Panel > Slab 

 
 
Step 2 

Using the draw tool to draw the foundation boundary on the activated Plan View or 3D View 

 
 
Step 3 

Click “Tick” to finish 
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Change Foundation Slab Type 

Step 1 

Select the Foundation Slab > Click the Edit Type in the Properties window 

 
 
Step 2 

Duplicate the existing type of Foundation > Type the Foundation name 

 
 
Step 3 

Edit the Foundation Structure and type the Foundation thickness in the Thickness field 

 
 
Step 4 

Click OK to finish. 
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By Structure - Foundation - Isolated 

Step 1 

Go to the Structure Tab > Foundation Panel > Slab 

 
 
Step 2 

To place a single footing click in the drawing area on the activated Plan View or 3D View. 
 
OR 
 
To place multiple instances of the footing beneath specific columns,  
go to the Modify | Place Isolated Foundation > Multiple panel > At Columns > Select the columns  
> Finish 

 
 
Step 3 

Select the footing > Click the Edit Type in the Properties window  

 
 
Edit the Foundation thickness, Width and Length in the Dimensions field. 

 
Step 4 

Click OK to finish.  
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By Structure - Foundation - Wall 

Step 1 

Go to the Structure Tab > Foundation Panel > Wall 

 
 
Step 2 

Select a wall to receive the wall foundation on the activated Plan View or 3D View. 

    
 
Step 3 

Select the Foundation Slab > Click the Edit Type in the Properties window  

 
 
Edit the Foundation Toe Length, Heel Length and Thickness in the Dimensions field. 

 
Step 4 

Click OK to finish.  
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5.1.2.3.2 Properties 

 
The major properties in Schedule: 

 Remark 
i) Naming 

Properties > Change Type Panel 
(1) Object Name e.g. Foundation Slab 

Footing-Rectangular 
Wall Foundation 

Figure 3.1 
Figure 3.2 
Figure 3.3 

ii) Parameter Input (By Modeller) 
Properties > Identity Data 
(2) Mark e.g. F1 

F4 
F3 

Figure 3.1 
Figure 3.2 
Figure 3.3 

Properties > Other 
(3) Concrete grade e.g. Grade 35/20 Figure 3.1-3.3 

iii) Parameter Input (By QS) 
Properties > Identity Data 
(4) Element Code e.g. XWRS Sub-Element Code; 

Figure 3.1 – 3.3 
iv) Material/ Thickness 

Properties > Edit Type  
(5) Material e.g. Concrete Figure 4.1 & 4.2; default 

material 
(6) Thickness e.g. 450 

300 
Retaining Wall – Foundation 
thickness; Figure 4.1; 
The foundation thickness can 
be found at the Type Name, 
see Figure 3.1 – 3.3 
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Figure 3.1 Foundation Properties Figure 3.2 Foundation Properties 

(By Foundation – Slab) (By Foundation – Isolated) 
 

 
Figure 3.3 Foundation Properties 

(By Foundation – Wall) 
  

(2) 

(3) 
(4) 

(1) 

(2) 

(3) 
(4) 

(1) 

(1) 

(2) 

(3) 
(4) 
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Figure 4.1 Foundation Type Properties 

(By Foundation – Slab) 
 

 
Figure 4.2 Foundation Type Properties 

(By Foundation – Wall) 
 

 
  

(6) 

(6) 

(5) 

(6) 

(5) 
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5.1.3 Quantity Take-off 
5.1.3.1 Excavation 
5.1.3.1.1 Sample of Cut & Fill Model 

 
1. Cut & Fill (Excavated Model) 
 
Plan View 

 
 

Section View 

 
 

3D View 

 
2. Cut & Fill (Filled Model) 
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Before 
(Original 
Terrain) 

 
 

Working – 1 
(Formed 
Terrain) 

 
 

Working – 2 
(Create the 
Building Pad) 
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After (Graded 
Region the 
Toposurface)  

 
 
Cut and Fill (Excavation Model) and Cut and Fill (Fill Model) are for use in measurement only. 

 
5.1.3.1.2 Building Pad - Application 

 
Create a new building pad (For Measurement of Excavation Works) 

Step 1 
Go to the Massing & Site Tab > Model Site Panel > Building Pad 

 
 
Step 2 
Using the draw tool to draw the Building Pad boundary on the activated Plan View or 3D View. 
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Step 3 
When drawing the Building Pad boundary, allow working space for excavation as appropriate. 

 
Example: 

 
 
Step 4 
Click “Tick” to finish 

  

Building Pad 

Retaining Wall 
Foundation 
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Using the Building Pad to set out the excavation depth 

Step 1 

Activate the 3D View. 
 
Step 2 

Make sure the Visibility Setting > Model Categories > Site Category & the Sub-category Pads are checked. 

 
 

Step 3 

Select Building Pad in 3D View, and change the properties Height offset From Level, to control the 
depth of excavation. 
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5.1.3.1.3 Building Pad - Properties 
 
1. The major properties in Schedule (Building Pad): 
 

  Remark 
(i) Name 

Properties > Change Type Panel 
(1) Object Name e.g. Pad Figure 5 
(2) Type Name e.g. Pad 500 Figure 5 

(ii) Pad Level 
Properties > Constraints 
(3) Level e.g. +00.00 mPD Figure 5 
(4) Height Offset From 

Level 
e.g. 65500 Figure 5; Pad level should be 

equal to the bottom level of 
structural foundation 

 

 
Figure 5 Building Pad Properties 

  

(1) 
(2) 

(3) 
(4) 
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2. The major properties in Schedule (Toposurface with Building Pad): 
 

 Remark 
(i) Parameter Input 

Properties > Identity Data 
(1) Comments e.g. Cut & Fill Figure 6 
(2) Name e.g. RW-1, RW-2 Figure 6 

 

 
Figure 6 Toposurface Properties 

  

(1) 
(2) 
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5.1.3.1.4 Cut & Fill Schedule 
 
Step 1 

Create a new Toposurface schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-
off 
 

 
Figure 9 
 

  Remark BQ Items 

Name e.g. RW-1, RW-2 Refer to Figure 6, (2)  

Cut e.g. 1348.45 m3 Refer to Figure 7; 

Using the Building Pad to 

control the excavation deep; 

Excavation; 

Excavating trenches for 

retaining walls; 

commencing at natural 

ground level; not 

exceeding 1.50m deep* 

Fill e.g. 0.00 m3   

Projected Area e.g. 231 m2   

 
* Further manipulation for the excavation depth in successive stages of 1.50m, backfilling to excavation and 

disposal could be done in Excel. 
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5.1.3.1.4 Cut & Fill Schedule (Cont’d) 
 

Step 2 

Schedule Properties and Setting 

 Fields  Calculated Value – Calculated Average Deep 

 
 

 

 

 Filter  Sorting/Grouping 

 
 

 

 Formatting - Cut  Formatting – Fill 
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5.1.3.2 RC Wall 
 
Step 1 

Create a new Wall schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 

 
 
 

  Remark BQ Items 

Object e.g. Basic Wall Refer to Figure 1, (1)  

Type e.g. 250 Refer to Figure 1, (2)  

Concrete grade e.g. Grade 35/20 Refer to Figure 1, (4)  

Wall Type e.g. Retaining Wall Refer to Figure 1, (6)  

Special Shape e.g. Curved Refer to Figure 1, (5)  

Width e.g. 0.25 Refer to Figure 2, (8)  

Volume e.g. 11.78 m3  Reinforced concrete; 

grade 35/20; retaining 

walls; 250 thick 

Mark e.g. RW-3 Refer to Figure 1, (3)  

Element Code e.g. XWRS Refer to Figure 1, (7)  
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5.1.3.2 RC Wall (Cont’d) 
 

Step 2 

Schedule Properties and Setting 

 Fields  Sorting/Grouping 

  
 

 Formatting - Volume  
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5.1.3.3 RC Foundation 
 
Step 1 

Create a new Structural Foundation schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ 
Material Take-off. 
 

 
 

  Remark BQ Items 

Object e.g. Foundation Slab Refer to Figure 3.1, (1)  

Type e.g. 450 Refer to Figure 3.1, (2)  

Concrete grade e.g. Grade 35/20 Refer to Figure 3.1, (4)  

Volume e.g. 63.90 m3  Reinforced concrete; grade 

35/20; foundations, 

attached bases or pile cap 

Mark e.g. F1 Refer to Figure 3.1, (3)  

Element Code e.g. XWRS Refer to Figure 3.1, (5)  
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5.1.3.3 RC Foundation (Cont’d) 
 

Step 2 

Schedule Properties and Setting 

 Fields  Sorting/Grouping 

  
 

 Formatting - Volume  
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5.1.3.4 Blinding 
 
Step 1 

Blinding layer will not be modelled in structural models, the volume of blinding can be calculated with 
reference to the foundation area. Create a new Structural Foundation schedule, refer to Part 7 
Techniques for QTO - 7.4 Schedule/ Material Take-off. 
 

 
 

  Remark BQ Items 

Object e.g. Foundation Slab Refer to Figure 3.1, (1)  

Type e.g. 450 Refer to Figure 3.1, (2)  

Area e.g. 142.00 m2   

Blinding Volume e.g. 7.10 m3 Volume = Area x Blinding 50 

thick 

Concrete; grade 20/20; 

blinding under foundations; 

50 thick 

Mark e.g. F2  Refer to Figure 3.1, (3)  

Element Code e.g. XWRS Refer to Figure 3.1, (5)  
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5.1.3.4 Blinding (Cont’d) 
 

Step 2 

Schedule Properties and Setting 

 Fields  Calculated Value – Blinding Volume 

 
 

 

 Sorting/Grouping  Formatting – Blinding Volume 
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5.1.3.5 Formwork 
5.1.3.5.1 Material Paint for Formwork 
 

Step 1 

Setting the Material Paint for calculating formwork, create a new material; refer to Part 7 Techniques for 
QTO – 7.6 New Material: 
 
 Remark 

(i) Material Name 

Material Browser 

(1) Name e.g. QTO – Retaining 
Wall (m2) (V) – Wall 

Material Naming refer to 
below table; Figure. 8 

(ii) Material Information 

Material Browser > Identity > Descriptive Information > 

(2) Description: e.g. Formworks 
 

The material function; 
Figure. 9 

(3) Type e.g. Wood Figure. 9 
(4) Comments e.g. QTO Figure. 9 

Material Browser > Graphics > Shading 

(5) Shading – Color 
 

e.g. RGB 000 255 000 
 

For identify the object’s 
material; Figure. 9 

 
Material Naming for QTO 

PART 1  PART2  PART3 
Filter - Description 1 - Description 2 

 
Example 

QTO - Retaining Wall (m2) (V) - Bed 
QTO - Retaining Wall (m2) (V) - Wall 
QTO - Retaining Wall (m2) (V) - Wall (Fair Faced Finish) 
QTO - Retaining Wall (m2) (V) - Edge Wall 
QTO - Retaining Wall (m) (V) - Edge Wall (<300) 
QTO - Retaining Wall (m) (S) - Top formwork (<300) 

 
PART 1 

Filter – for searching the material 
 

PART 2 

(m) – calculate object in run 
(m2) – calculate object in area 
(H) – horizontal face 
(V) – vertical face 
(S) – sloping face 
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Figure 8 Material Browser 
 

 

 
Figure 9 Material Editor 
 
Step 2 

Use painting function; refer to Part 7 Techniques for QTO - 7.7 Paint Function. 

  

(1) 

(1) 

(2) 
(3) 
(4) 

(5) 
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5.1.3.5.2 Formwork Schedule 
 
Step 1 
Create a new Multiple Categories material take-off schedule, refer to Part 7 Techniques for QTO - 7.4 
Schedule/ Material Take-off. 
 

 
 

  Remark BQ Items 

Object e.g. Foundation Slab Refer to Figure 3.1, (1)  

Type e.g. 450 Refer to Figure 3.1, (2)  

Material: Name e.g. QTO – Retaining Wall 

(m2) (V) - Bed 

Refer to Figure 9, (1)  

Material: Description e.g. Formworks Refer to Figure 9, (2)  

Material: Comments e.g. QTO Refer to Figure 9, (4)  

Material: Area e.g. 34.65m2 the painted area; 

 

Sawn formwork; 

vertical surface; 

foundations, pile caps, 

ground beams and the 

like 

Mark e.g. F1  Refer to Figure 3.1, (3)  

Element Code e.g. XWRS Refer to Figure 3.1, (5)  
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5.1.3.5.2 Formwork Schedule (Cont’d) 
 

Step 2 

Schedule Properties and Setting 

 Fields  Filter 

  
 

 Sorting/Grouping  Formatting – Material: Area 
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5.1.3.6 Movement Joint 
 
Step 1 
Create a new Multiple Categories material take-off schedule, refer to Part 4 Techniques for QTO - 4.3 
Schedule/ Material Take-off. 
 

 
 

  Remark BQ Items 

Object e.g. Basic Wall Refer to Figure 1, (1)  

Type e.g. 350 Refer to Figure 1, (2)  

Material: Name e.g. QTO – Retaining Wall 

(m2) (V) – Edge Wall 

Refer to Figure 8, (1)  

Material: Description e.g. Formworks Refer to Figure 9, (2)  

Material: Comments e.g. QTO Refer to Figure 9, (4)  

Material: Area e.g. 1.05 m2  Forming movement 

joints; formwork; in walls; 

20 wide x 350 deep 

 

Length of Movement 

Joint = Material area / 

Wall Thickness; 

e.g. 1.05 / 0.35 = 3m 

Mark e.g. RW-1 Refer to Figure 1, (3)  
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5.1.3.6 Movement Joint (Cont’d) 
 

Step 2 

Schedule Properties and Setting 

 Fields  Filter 

  
 

 Sorting/Grouping  Formatting – Material: Area 
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5.2 Concrete Works 
 
This section mainly focuses on the following four main structural elements which are in the same 
concrete mix: 
i. Structural Wall 
ii. Structural Framing 
iii. Structural Column 
iv. Structural Slab 
 

5.2.1 Basic Information 

5.2.1.1 Building Element to Model: Concrete Structural Object 
 
Modelling elements: 

Elements Object Category 

Structural Column Structure / Structure / Column 

Structural Wall Structure / Structure / Wall: Structural 

Structural Framing Structure / Structure / Beam 

Structural Slab Structure / Structure / Floor: Structural 

 
 

5.2.2 Modelling Approach 

5.2.2.1 Structural Column 
5.2.2.1.1 Naming Convention 

 
Type of Column: Concrete Column 
Object Naming:  
Details of naming convention shall refer to Section 2.5.4 of BIM Guide for Structural Engineering issued 
by Structural Engineering Branch, Architectural Services Department. 
 

Type Naming: 
a) Rectangular Column 

1000x500 
 
 
 
 
b) Circular Column 

500DIA. 
 
 

  

Breadth Depth 

Diameter 
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5.2.2.1.2 Shared Parameters 

 
The following parameters shall be set in column objects: 
 
Under Dimensions 

Description Parameter Type / Instance 

Breath of Column (Rectangular Column) QS Breadth Type 

Depth of Column (Rectangular Column) QS Depth Type 

Diameter of Column (Circular column) QS Diameter Type 

 
Under Other (Information input by Modeller) 

Description Parameter Type / Instance 

Concrete Grade for Column Concrete grade Instance 

For liquid retaining structure, should be 
specified in parameter. 

Liquid retaining structure Instance 

 

Under Identity Data (Information input by Modeller) 

Description Parameter Type / Instance 

Column Mark Mark Default parameter 

 
For QTO, Shared Parameters QS Breadth and QS Depth shall be added in Column Object. 
(Remark: Though the breadth “b” and depth “h” of a column have been defaulted in the column object, 
however, they cannot be extracted to the schedule for QTO.) 
 
Step 1 

Manage > Shared Parameter 
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Step 2 

In Shared Parameter Brower, create a new group and name the group e.g. “QTO” and create new shared 
parameter QS Breath and QS Depth. 

 

 
 
 
 
 

Step 3 

Home Button > Edit Family 
 
 

 
 

 

Edit Object Type 

New object parameter, and then 
select the parameter created 
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Step 4 

Set QS Breadth = b, QS Depth = h 

 
 

Step 5 

Load the Column object into project.  
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5.2.2.1.3 Creating a Column 
 
All structural column shall be modelled as Structure > Column 

 
 

 
 

 
Structural Column 
(a): Reference Level: e.g. 1/F 

 Place Structural Column select Depth: Lower Level (e.g. G/F) 
Base Level: Lower Level (e.g. G/F) 
Top Level: Reference Level (e.g. 1/F) 

All columns shall be defined between the levels where they serve as support for other elements and top of 
their supporting elements (like top of the column / wall / beam and foundation below), with required level 
offsets. 

(b): Add a parameter to specify concrete grade. 
(c): Add a parameter to specify liquid retaining structure. 
(d): Add Column Mark in the default parameter Mark.  

(a) 

(d) 

(c) 

(b) 
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5.2.2.2 Structural Wall 
5.2.2.2.1 Naming Convention 

Details of naming convention shall refer to Section 2.5.4 of BIM Guide for Structural Engineering issued 
by Structural Engineering Branch, Architectural Services Department. 
 
Type of Wall: Structural Wall/ Hanger Wall 

Non-structural Wall/ Parapet Wall (Refer to Architectural Model) 
 
System Object: Basic Wall (Wall is a System Object that means object file cannot be created for wall 
but it can be defined new wall types for individual models.) 
 
Type Naming: 

300 
 
 
 

5.2.2.2.2 Shared Parameters 
 

The following parameters shall be set in wall objects: 
 
Under Other 

Description Parameter Type / Instance 

Concrete grade for wall Concrete grade Instance 

For liquid retaining structure should be 
specified in parameter. 

Liquid retaining structure Instance 

Identification of curved wall QS Curved element Instance 

Identification of Wall type1 
(e.g. Hanger wall, Structural wall, etc.) 

Wall type Instance 

 
Under Identity Data 

Description Parameter Type / Instance 

Wall Mark Mark Default parameter

 
  

                                                 
1 Hanger wall shall be identified by modeller. Structural wall may be identified by QS for filtering in Schedule. 
 

Wall thickness 
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5.2.2.2.3 Creating a Wall 
 
Step 1 

Selecting ribbon, Home tag > Structure panel > Wall dropdown list > Structural Wall 

 
 

Step 2 

Select Edit type to create different wall type. 
 
 
 

 

 
 

 
 
 

  

Create different wall thickness 
by Duplicate button 

Modify wall thickness by 
Edit button 

Manual type in 
value of thickness 
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Step 3 

Draw the wall. 
 
 
 
 

 
 

 
  

(a) 

(e) 

(b) 

(f) 

(d) 

(c) 
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Structural Wall 
(a): Structural Wall 

All walls shall be defined with Top and Base Constraints between the levels where they serve as support 
for other elements and top of their supporting elements. Level offsets can be applied as appropriate. The 
top level of walls shall be extended to top of slabs being supported instead of to the soffits of slab elements 
only.  
e.g. Reference Level: 6/F 

 Place Structural Wall select Depth: Lower Level (e.g. 5/F) 
Base Constraint: Lower Level (e.g. 5/F) 
Top Constraint: Reference Level (e.g. 6/F) 

 
Hanger Wall 
e.g. Hanger walls supported by 6/F structural member 

(1) Both Top and Base Constraints of hanger walls shall be assigned with identical level and with 
negative value of Base Offset which value made equal to required hanger wall height (including slab 
thickness). 
 Reference Level: 6/F 

Place Structural Wall select Depth: Unconnected 1500 

 
Base Constraint: Reference Level (e.g. 6/F) 
Top Constraint: Reference Level (e.g. 6/F) 
Base Offset: e.g. -1500mm (equal to required hanger wall height including slab thickness) 

(2) Hanger walls shall be defined with Top and Base Constraints between the levels with base offsets 
applied where equal to the height from the structural floor level to soffit of hanger wall. 
 Reference Level: 6/F 

Place Structural Wall select Height: Above level (6/F) 

 
Base Constraint: Reference Level (e.g. 5/F) 
Top Constraint: Upper Level (e.g. 6/F) 
Base Offset: e.g. 2250mm 

 
Structural Wall not in full floor height 
Both Top and Base Constraints of structural walls shall be assigned with identical level with Top Offset 
made equal to required height (excluding slab thickness). 
e.g. Reference Level: 6/F 

 Place Structural Wall select Height: Above Level (e.g. R/F) 
Top Offset: e.g.1500mm (equal to required height) 
Base Constraint: Reference Level (e.g. 6/F) 
Top Constraint: Reference Level (e.g. 6/F)* 

*As the Top and Base Constraints set as the identical level will have the Error warning. Set the 
Top Constraint to above level and input Top Offset first, then set the Top Constraint to the 
Reference Level and then placing the structural wall. 

 



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 198 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date:  Dec 2023 

 

 
(b): Add a parameter to specify concrete grade. 
(c): Add a parameter to specify liquid retaining structure. 
(d): Add a parameter to specify curved wall. 
(e): Add a parameter to specify wall type1 (e.g. structural wall, hanger wall, parapet wall, etc.). 
(f): Add Wall Mark in the default parameter Mark.  

 
  

                                                 
1 Hanger wall shall be identified by modeller. Structural wall may be identified by QS for filtering in Schedule.  
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5.2.2.3 Structural Framing 
5.2.2.3.1 Naming Convention 

 
Type of Structural Framing: Concrete Beam 
 
Object Naming: 

Details of naming convention shall refer to Section 2.5.4 of BIM Guide for Structural Engineering issued 
by Structural Engineering Branch, Architectural Services Department. 
 
Type Naming: 
 
Rectangular Beam 

750x500 
 
 
 
 

5.2.2.3.2 Shared Parameters 
 
The following parameters shall be set in beam objects: 
 
Under Dimensions 

Description Parameter Type / Instance 

Depth of beam QS Depth Type

Width of beam QS Width Type 

 
Under Other (Information input by Modeller) 

Description Parameter Type / Instance 

Concrete Grade for Beam Concrete grade Instance 

For liquid retaining structure should be 
specified in parameter. 

Liquid retaining structure Instance 

Identification of curved beam QS Curved element Instance 

 
Under Identity Data (Information input by Modeller) 

Description Parameter Type / Instance 

Beam Mark Mark Default parameter

 
For QTO, Shared Parameters QS Depth and QS Width shall be added in the Beam Object. (*Details refer to the 
method of Structural Column) 
 

Depth Width 
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5.2.2.3.3 Creating a Beam 
 
All beams shall be modelled as Structure > Beam 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Structural Framing 
(a): Select Type Selector, select different kind of ADS structural framing. 
(b): Reference Level: Above Level 
(c): The alignments of the beam shall be selected in y Justification (Origin/Left/Center/Right); z Justification 

(Top/Center/Bottom). 
 Inverted beam: z Justification to “Top”, z Offset Value input value e.g. 550, say 700 (Depth) -150 

(slab thickness). 
(d): Add a parameter to specify concrete grade. 
(e): Add a parameter to specify liquid retaining structure. 
(f): Add a parameter to specify curved beam. 
(g): Add Beam Mark in the default parameter Mark.  

(a) 

(c) 

(b) 

(g) 

(d) 

(e) 

(f) 
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5.2.2.4 Structural Slab 
5.2.2.4.1 Naming Convention 

Details of naming convention shall refer to Section 2.5.4 of BIM Guide for Structural Engineering issued 
by Structural Engineering Branch, Architectural Services Department. 
 
Type of Slab: Structural Slab / Transfer Plate 
 
System Object: Floor (Floor is a System Object that means object file cannot be created but it can be 
defined new slab types for individual models.) 
 
Type Naming: 

 
150 

 
 
 

5.2.2.4.2 Creating a Slab 
 
Structural Slab shall be modelled as follow: 

 
 
(a) Slab is offset downward from the level on which it is created. 
(b) Slab shall be modelled panel by panel.  
(c) Slab boundaries (except free edge slab) shall be defined either: 

i) along the center lines of supporting beams; or 
ii) along the center lines of column; or 
iii) along the center lines of structural wall. 

(d) No overlapping of slabs shall be allowed. 
  

Slab thickness 
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5.2.2.4.3 Shared Parameters 
 
The following parameters shall be set in Slab objects: 
 
Under Other 

Description Parameter Type / Instance 

Concrete Grade for Slab Concrete grade Instance 

For liquid retaining structure should be 
specified in parameter. 

Liquid retaining structure Instance 

Identification of sloping slab QS Sloping element Instance 

Identification of curved slab QS Curved element Instance 

 

Under Identity Data 

Description Parameter Type / Instance 

Slab Mark Mark Default parameter
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5.2.3 Quantity Take-off 

Step 1: Setup new Shared Parameters to all elements. 
Step 2: Draw QTO Floor slab and input the relevant information. 
Step 3: Identify and input the relevant information for other elements. 
Step 4: Create new QTO Schedules. 
 

5.2.3.1 Setup new Shared Parameters 
 
The followings parameters shall be set in the QS model to facilitate QTO. Refer to Part 7 Techniques for 
QTO – 7.2 Shared Parameters and 7.3 Project Parameters for the details. 
 

5.2.3.1.1 Structural Column 
 
Under Dimensions 

Description Parameter Type / Instance 

For calculate the column height Deduct slab thickness Instance 

 
Under Identity Data 

Description Parameter Type / Instance 

Sub-element Code 

(e.g. FNSE – Columns in substructure, 
SCFF – Columns in superstructure, etc.) 

Element Code Instance 

For case if columns have special adjustment  
(e.g. corner columns, edge columns, etc.) 

QS tag Instance 

For the columns with tagging in QS tag, calculate the 
formwork adjustment 

Formwork Adjustment Instance 

Special type of formworks  
(e.g. left-in, formwork to produce fair faced finish, etc.) 

Special Formwork Instance 

 
5.2.3.1.2 Structural Wall 

 
Under Dimensions 

Description Parameter Type / Instance 

For calculate the structural wall height Deduct Slab thickness Instance 

 
Under Identity Data 

Description Parameter Type / Instance 

Sub-element Code 

(e.g. FNSE – Structural Wall in substructure, 
SCSW – Structural Wall in superstructure, etc.) 

Element Code Instance 
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Under Identity Data (Cont’d) 
 

Description Parameter Type / Instance 

Special shape1 for Wall elements (e.g. tapered, 
irregular, etc.) 

Special shape Instance 

For case if walls have special adjustment  
(e.g. Slab Edge, etc.) 

QS tag Instance 

For the walls with tagging in QS tag, calculate the 
formwork adjustment 

Formwork Adjustment Instance 

Special type of formworks  
(e.g. left-in, formwork to produce fair faced finish, etc.) 

Special Formwork Instance 

For identify any open end structural wall, 
measurement for the “edges and breaks in walls” 

Wall Edge Instance 

For the walls with tagging in Wall Edge, calculate the 
edge formwork in (m) for wall thickness ≤300mm 

Edge Fwk (m) Instance 

For the walls with tagging in Wall Edge, calculate the 
edge formwork in (m2) for wall thickness >300mm 

Edge Fwk (m2) Instance 

 
5.2.3.1.3 Structural Framing 

 
Under Dimensions 

Description Parameter Type / Instance 

For calculate the beams depth. Deduct Slab thickness Instance 

 
Under Identity Data 

Description Parameter Type / Instance 

Sub-element Code 

(e.g. FNSE – Beams in substructure, 
SCFF – Beams in superstructure,  
SCSL – Stair Beams in superstructure, etc.) 

Element Code Instance 

For case if beams have special adjustment  
(e.g. edge beams, cantilever beams, cantilever edge 
beams, upstand beams. Etc.) 

QS tag Instance 

For the beams with tagging in QS tag, calculate the 
formwork adjustment 

Formwork Adjustment Instance 

Special type of formworks  
(e.g. left-in, formwork to produce fair faced finish, etc.) 

Special Formwork Instance 

Lower Structural Floor Level, for calculate the 
strutting height to soffit of beam 

Lower SFL Instance 

                                                 
1 Curved wall shall be identified by modeller. All other special shaped wall may be identified by QS if required. 
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5.2.3.1.4 Structural Slab 
 
Under Identity Data 

Description Parameter Type / Instance 

Sub-element Code 

(e.g. FNGF – Ground floor slabs in substructure, 
SCUF – Suspended slabs in superstructure, 
SCRF – Roof slabs in superstructure, 
SCSL – Stair slabs in superstructure, etc.) 

Element Code Instance 

For input the slab thickness Slab thickness Instance 

Special type of formworks  
(e.g. left-in, formwork to produce fair faced finish, etc.) 

Special Formwork Instance 

Lower Structural Floor Level, for calculate the 
strutting height to soffit of slabs 

Lower SFL Instance 

 
 
5.2.3.1.5 Parameter Properties Setting 

 
a) Deduct slab thickness 
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5.2.3.1.5 Parameter Properties Setting (Cont’d) 
 
b) Element Code 
 

 
 
 

c) QS tag 
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5.2.3.1.5 Parameter Properties Setting (Cont’d) 
 

d) Formwork adjustment 
 

 
 

e) Special Formwork 
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5.2.3.1.5 Parameter Properties Setting (Cont’d) 
 

f) Wall Edge 
 

 
 

g) Edge fwk (m) 
 

 
  



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 210 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date:  Dec 2023 

 

5.2.3.1.5 Parameter Properties Setting (Cont’d) 
 

h) Edge fwk (m2) 
 

 
 

i) Lower SFL 
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5.2.3.3 Input Information in structural elements 
5.2.3.3.1 Structural Column 

 

 

 
 
 
 
 
 
 
 

Structural Column 
(a): Insert the thickness of slab to the parameter Deduct slab thickness to deduct overlapping concrete volume 

between structural column and slab. Enter “0”(zero) for no slab to be deducted. 
(b): Input the Sub-Element Code, e.g. FNSE – Columns in substructure, SCFF – Columns in superstructure, etc. 
(c): Tag the column if requires formwork adjustment, e.g. Edge Column, Corner Column, etc. 
(d): For the columns with tagging in QS tag, calculate the formwork adjustment. 
(e): Identify any special formwork to be used, e.g. left-in, formwork to produce fair faced finish, etc. 

  

(a) 

(e) 

(c) 

(d) 

(b) 

Length 
(Default 
height, 
can be 
drawn in 
schedule) 

Length – (a) 

(c): Tag the column, 
e.g. Edge Column 

Formwork adjustment: 
(d) = (a) x QS Breadth 

(a) 

Formwork adjustment: 
(d) = (a) x (QS Breadth + QS Depth) 

(c): Corner Column 
(c): Edge Column 
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5.2.3.3.2 Structural Wall 
 

 
 
Structural Wall 
(a): Insert the thickness of slab to the parameter Deduct slab thickness to deduct overlapping concrete volume 

between structural wall and slab. If the structural wall are modelled with structural beam, input the depth of 
beam instead of the slab thickness. Enter “0”(zero) for no slab or beam to be deducted.  

(b): Input the Sub-Element Code, e.g. FNSE – Structural Wall in substructure, SCSW – Structural Wall in 
superstructure, etc. 

(a) 

(e) 

(c) 

(d) 

(b) 

(f) 

(g) 

(h) 

(f): Identify any “edges in walls”,  
tag the walls, one side or both sides 

(g): Input value for wall thickness ≤ 300mm 
(h): Input value for wall thickness > 300mm 

(a) 

(c): Tag the wall, 
e.g. Slab Edge 

Unconnected Height 
(Default height, can be 
drawn in schedule) 

Unconnected Height – (a) 

Formwork adjustment: 
Slab edge assoicated with wall formwork 
(d) = (a) x Length 

(i) 
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(c): Tag the structural wall if requires formwork adjustment, e.g. Slab Edge, etc. 
(d): For the structural walls with tagging in QS tag, calculate the formwork adjustment. 
(e): Identify any special formwork to be used, e.g. left-in, fwk to produce fair faced finish, etc. 
(f): For identify any open end structural wall, tag the walls for measurement of “edges and breaks in walls”, e.g. 

one side, both sides, etc. 
(g): For the walls with tagging in Wall Edge, calculate the edge formwork in (m) for wall thickness ≤ 300mm. 
(h): For the walls with tagging in Wall Edge, calculate the edge formwork in (m2) for wall thickness > 300mm. 
(i): For identify any special shape1 for wall elements (e.g. tapered, irregular, etc.) 

  

                                                 
1 Curved wall shall be identified by modeller. All other special shaped wall may be identified by QS if required. 
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5.2.3.3.3 Structural Framing 
 

 
 
Structural Framing 
(a): Insert the thickness of slab to the parameter Deduct slab thickness to deduct overlapping concrete volume 

between beam and slab. Enter “0”(zero) for no slab to be deducted. 
(b): Input the Sub-Element Code, e.g. FNSE – Beams in substructure, SCFF – Beams in superstructure, SCSL 

– Stair Beams in superstructure, etc. 
(c): Tag the beam if requires formwork adjustment, e.g. edge beams, cantilever beams, cantilever edge beams, 

upstand beams, etc. 
(d): For the beams with tagging in QS tag, calculate the formwork adjustment. 
(e): Identify any special formwork to be used, e.g. left-in, fwk to produce fair faced finish, etc. 
(f): Input the lower structural level, for calculate the strutting height to soffit of beam. 

 

(a) 

QS Depth  

(c): Tag the beam, 
e.g. Edge Beam 

(c): Tag the beam, 
e.g. Cantilever Edge 
Beam 

Formwork adjustment: 
(d) = (a) x Cut Length +  

QS Breadth x QS Depth 
Formwork adjustment: 
(d) = (a) x Cut Length 

(a) 
QS Depth - (a) 

(c) 

(b) 

(e) 

(d) 

(c): Edge Beam 

(c): Cantilever Edge Beam 

(c): Cantilever Beam 

(f) 

(f): Lower Structural Level 
e.g. 149.400 
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5.2.3.4 Create QTO Schedules 
5.2.3.4.1 Structural Column 

 
Step 1 

Create a new Structural Columns schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 
 
Step 2 

Schedule Properties and Setting 

 Fields  Calculated Value - SMM Volume 
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5.2.3.4.1 Structural Column (Cont’d) 
 
 Calculated Value – SMM Formwork  Filter 

 

 
 

 Sorting/Grouping  Formatting – SMM Volume, SMM Formwork  
and Formwork adjustment 
 

 
 

 

FNSE for 
substructure 
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5.2.3.4.1 Structural Column (Cont’d) 
 
(a) Concrete Volume = ∑ Column Concrete Volume 
 

 
: 
: 

 
 
 
 
 
 
Remarks: 
To differentiate quantities related to different concrete mix, concrete type, etc., use the Duplicate View to duplicate the schedule and use Filter to create 
different schedules. 

 

 

Fields name: Length is a default height, 
the height included the slab thickness. 

For the circular columns, adjust the formula of 
SMM Volume appropriately. 
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5.2.3.4.1 Structural Column (Cont’d) 
 
(b) Formwork Area = ∑ Column Formwork Area + ∑ Formwork Adjustment 
 

 
: 
: 

 
 
 
 
 

Remarks: 
To differentiate quantities related to different special formwork, etc., use the Duplicate View to duplicate the schedule and use Filter to create different 
schedules.  

For the circular columns, adjust the formula of 
SMM Formwork appropriately. 

Fields name: Length is a default height, 
the height includes the slab thickness. 
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5.2.3.4.2 Structural Wall 
 
Step 1 

Create a new Walls schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 
 
Step 2 

Schedule Properties and Setting 

 Fields  Calculated Value – SMM Volume 
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5.2.3.4.2 Structural Wall (Cont’d) 
 

 Calculated Value – SMM Formwork  Filter 

 

 
 

 Sorting/Grouping  Formatting – SMM Volume, SMM Formwork,  
Formwork adjustment, Edge fwk (m) and 
Edge fwk (m2) 

  

FNSE for substructure 

Create schedule for each type of wall 
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5.2.3.4.2 Structural Wall (Cont’d) 
 
(a) Concrete Volume = ∑ Wall Concrete Volume (For each type and every thickness) 

 
: 
: 

 
 
 
 
 

Remarks: 
To differentiate quantities related to different concrete mix, concrete type, etc., use the Duplicate View to duplicate the schedule and use Filter to create different 
schedules.  

 

Fields name: Unconnected Height is a 
default height, the height includes the slab 
thickness. 

Adjust the formula of SMM Volume to 
suit special shape concrete structure 
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5.2.3.4.2 Structural Wall (Cont’d) 
 
(b) Formwork Area = ∑ Wall Formwork Area + ∑ Formwork Adjustment 

 
: 
: 

 
 
 

 
Remarks: 
To differentiate quantities related to different special formwork, etc., use the Duplicate View to duplicate the schedule and use Filter to create different 
schedules.  

Fields name: Unconnected Height is a 
default height, the height includes the slab 
thickness. 

Adjust the formula of SMM Formwork 
to suit special shape concrete structure 
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5.2.3.4.2 Structural Wall (Cont’d) 
 
(c) (i) Edges and breaks of wall ; wall thickness < 300 thick or = 300 thick = ∑ Edge Formwork (m) 

(ii) Edges and breaks of wall ; wall thickness > 300 thick = ∑ Edge Formwork (m2)  

 
: 
: 

 
 

 
 
Remarks: 
To differentiate quantities related to different special formwork, etc., use the Duplicate View to duplicate the schedule and use Filter to create different 
schedules.  

Fields name: Unconnected Height is a 
default height, the height includes the slab 
thickness. 
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5.2.3.4.3 Structural Framing 
 
Step 1 

Create a new Structural Framing schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 
 
Step 2 

Schedule Properties and Setting 

 Fields  Calculated Value – SMM Volume 
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5.2.3.4.3 Structural Framing (Cont’d) 
 

 Calculated Value – SMM Formwork  Calculated Value – Beam Depth (below slab) 

 
 

 
 

 Calculated Value – Strutting Height  Filter 

 
 

 
 

  

Create schedule for different type of concrete 

FNSE for substructure; SCSL for Stair Beams 
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5.2.3.4.3 Structural Framing (Cont’d) 
 

 Sorting/Grouping  Formatting – SMM Volume, SMM Formwork and  
Formwork adjustment 
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5.2.3.4.3 Structural Framing (Cont’d) 
 
(a) Concrete Volume = ∑ Beam Concrete Volume 
 

 
: 
: 

 
 
 
 
 
 
Remarks: 
To differentiate quantities related to different concrete mix, concrete type, etc., use the Duplicate View to duplicate the schedule and use Filter to create 
different schedules.  

 

Fields name: Length is a default length which 
includes the lapping length with other structural 
elements. To obtain the actual length of beams for 
QTO, Fields name: Cut Length shall be used. 

Adjust the formula of SMM Volume to 
suit special shape concrete structure 
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5.2.3.4.3 Structural Framing (Cont’d) 
 
(b) Formwork Area = ∑ Beam Formwork Area + ∑ Formwork Adjustment 
 

(i) Duplicate View to duplicate the schedule and use Filter to create different formwork schedules. 
For example: 

 
 
 Formatting 

 

Create schedule for different strutting height; 
>3.5m in stage of 1.5m 

Create schedule for depth of beams 
(below soffit of slab) ≤1m and >1m 
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5.2.3.4.3 Structural Framing (Cont’d) 
 

 
 
 
 
 

Remarks: 
To differentiate quantities related to different special formwork, etc., use the Duplicate View to duplicate the schedule and use Filter to create different 
schedules. 

  

Adjust the formula of SMM Formwork 
to suit special shape concrete structure 
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5.2.3.4.4 Structural Slab 
 
Step 1 

Create a new Floors schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-off. 
 
Step 2 

Schedule Properties and Setting 

 Fields  Calculated Value – SMM Volume 
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5.2.3.4.4 Structural Slab (Cont’d) 
 

 Calculated Value – Strutting Height  Calculated Value – Fwk SH ≤ 3.5m 

 
  

 
 Calculated Value – Fwk SH e.x.3.5m ≤5m  Calculated Value – Fwk SH e.x.5m ≤6.5m 
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5.2.3.4.4 Structural Slab (Cont’d) 
 

 Filter  Sorting/Grouping 

 
 

 

 Formatting – SMM Volume, Fwk SH ≤ 3.5m, Fwk SH e.x.3.5m ≤5m 
and Fwk SH e.x.5m ≤6.5m 

 

 

 

Create schedule for different type of concrete 
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5.2.3.4.4 Structural Slab (Cont’d) 
 
(a) Concrete Volume = ∑ Slab Concrete Volume 
 

 
 

 
Remarks: 
To differentiate quantities related to different concrete mix, concrete type, etc., use the Duplicate View to duplicate the schedule and use Filter to create 
different schedules.  
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5.2.3.4.4 Structural Slab (Cont’d) 
 
(b) Formwork Area = ∑ Beam Formwork Area + ∑ Deduction of overlapping area 
 

 
 
 
Remarks: 
To differentiate quantities related to different special formwork, etc., use the Duplicate View to duplicate the schedule and use Filter to create different 
schedules. 
 
∑ Deduction of overlapping area 

 Deduction of Coulmn Cross Section Area (using Structural Column’s Schedule) 
 Deduction of Slab-Wall Overlapping Area (using Wall’s Schedule) 
 Deduction of Beam Soffit Formwork Area (using Structural Framing’s Schedule) 
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5.3 Structural Steel 
 

This section mainly focuses on the following structural steel elements: 

i. Structural Column  

ii. Structural Beam 

 

5.3.1 Basic Information 

5.3.1.1 Building Element to Model 

Modelling elements 

Elements Object Category 

Structural Column Structure / Structure / Column 

Structural Beam Structure / Structure / Beam  

 

5.3.2 Modelling Approach 

5.3.2.1 Naming Convention 
 

Object Naming: 

Details of object naming convention shall refer to Section 2.5.4 of BIM Guide for Structural Engineering 

issued by Structural Engineering Branch, Architectural Services Department. 

 

Type Naming: 

a) 356x368x153kg/m UC 

 

 

Type of steel Shape Naming 

UC Universal Columns 

 

D x B x kg/m UC 

UB Universal Beams 

 

D x B x kg/m UB 

  

D B kg/m Type of steel 
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Type Naming: (Cont’d) 

 

Type of steel Shape Naming 

Joist Joist 

 

D x B x kg/m Joist 

PFC Parallel Flange Channel 

 

D x B x kg/m PFC 

UBP Universal Bearing Piles 

 

D x B x kg/m UBP 

 

b) 120x120x12 Angle 

 

 

Type of steel Shape Naming 

Angle Equal Angle 

 

A x A x t Angle 

Angle Unequal Angle 

 

A x B x t Angle 

 

c) 60x3 CHS 

 

 

Type of steel Shape Naming 

CHS Circular Hollow Section 

 

D x t CHS 

  

A A or B t Type of steel 

D t Type of steel 
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Type Naming: (Cont’d) 

 

d) 60x40x3 RHS 

 

 

Type of steel Shape Naming 

SHS Square Hollow Section 

 

D x D x t SHS 

RHS Rectangular Hollow Sections 

 

D x B x t RHS 

 

5.3.2.2 Shared Parameters 

 

The following parameters shall be set in Structural Column / Structural Beam objects: 

 

Under Identity Data 

Description Parameter Type / Instance 

Structural Steel Grade for column / 

beam element 

QS Steel grade Instance 

 

Under Other 

Description Parameter Type / Instance 

Curved column/beam QS Curved element Instance 

Tapered column/beam QS Tapered element Instance 

Sloping beam QS Sloping element Instance 

 

  

D D or B t Type of steel 
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5.3.2.3 Creating a Structural Column 

All structural column shall be modelled as Structure > Column  

 
 

(a):  Select Type Selector, select ADS structural steel column. 

(b):  Add a parameter to specify structural steel grade. 

(c):  Add parameters to specify curved or tapered column. 

  

(a) 

(b) 

(c) 
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5.3.2.4 Creating a Structural Beam 

All structural beam shall be modelled as Structure > Beam  

 
 

(a): Select Type Selector, select ADS structural steel beam. 

(b): Add a parameter to specify structural steel grade. 

(c): Add parameters to specify curved, sloping or tapered beam. 

  

(c) 

(b) 

(a) 
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5.3.3 Quantity Take-off 

5.3.3.1 Setup new Shared Parameters 
 

For QTO, Shared Parameters Weight per unit length shall be added in structural column / structural 

beam object. 

Step 1 

Manage > Shared Parameters 

 

Step 2 

In Shared Parameters Brower, create a new group and name the group e.g. “QS QTO” and create a new 

shared parameter Weight per unit length. 

 

In Parameter Properties dialog box, enter “Weight per unit length”, set the Discipline to Common, and set 

the Type to Number.  

 

Click OK to close each dialog box. 
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5.3.3.1 Setup new Shared Parameters (Cont’d) 

Step 3 

Home Button > Edit Family 

 

 
 

Step 4 

Load the Column / Beam object into project. 
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5.3.3.1 Setup new Shared Parameters (Cont’d) 

Step 5 

Input the details into the parameter Weight per unit length. 
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5.3.3.2 Structural Column 

Step 1 

Create a new Structural Columns schedule, refer to Part 7 Techniques for QTO - 7.4 Schedule/ Material Take-

off. 

 
Step 2 

Schedule Properties and Setting 

 

  

 Fields  Calculated Value - Kg 
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5.3.3.2 Structural Column (Cont’d) 

 Filter   Sorting/Grouping 

  
 Formatting  

 

 

Sample of Structural Columns Schedule 

 



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 245 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date:  Dec 2023 

 

5.3.3.3 Structural Beam 

 

Step 1 

Create a new Structural Beams schedule under Structural Framing category, refer to Part 7 Techniques for QTO 

- 7.4 Schedule/ Material Take-off. 

 
 

Step 2 

Schedule Properties and Setting 

  

 Fields  Calculated Value - Kg 
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5.3.3.3 Structural Beam (Cont’d) 

 

  

 Filter   Sorting/Grouping 

  
 Formatting  
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5.3.3.3 Structural Beam (Cont’d) 

 

  

Sample of Structural Beams Schedule 
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6. Detailed Modelling Guidelines – Building Services Installations 

 

6.1 Air Conditioning and Mechanical Ventilation (HVAC) System 
 

This section includes air conditioning, refrigeration, ventilation and central control & monitoring system 

elements only. 

 

6.1.1 Basic Information 

6.1.1.1 Building Services Elements to Model: HVAC System 

 

The following details of Air-conditioning and Mechanical Ventilation (HVAC) System should be developed 

in BIM models, but not limited to: 

- AHU/PAU/FCU/ split type A/C unit/VAV units/ CARC/ fans and other major equipment are modelled 

as generic objects with overall sizes; 

- All elements shall be modelled with appropriate System Object, include air grilles/diffusers of 

various types, air ducts, chilled water pipe, refrigerant pipe, etc.; 

- Control/supervisory panel, temperature control switch, FCU speed control switch, etc. with 

indicative size and locations only; 

- Pipes/ducts/cable trunkings/cable trays running into/out of the plant room are modelled to verify the 

possible routing, headroom and space for maintenance; 

- Details of equipment limited to overall sizes and positions of connections. 

 

6.1.1.2 Level of Information Need (LOIN) 

 

The BIM models are to be built and created stage by stage based on the project programme. The 

recommended LOIN for individual building services object/ element at different stages shall follow the 

requirements stated in Clause 4.6 Level of Information Need (LOIN) of the Building Information Modelling 

(BIM) Guide for Building Services Installation issued by Building Services Branch (BSB), Architectural 

Services Department. 
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6.1.2 Modelling Approach 

6.1.2.1 Modelling Process of HVAC BIM Model 

 

The HVAC model can be modelled in the manner illustrated in the following steps. 

Step 1: Creating Diffuser and Mechanical Equipment 

Choose and place the right diffusers and equipment based on the design drawing. 

 

Step 2: Duct/Pipe Layout 

Step 2.1 Complete the HVAC systems with ducts/pipes. 
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Step 2.2 Change the colour of different types of mechanical equipment and ducts. 

 

The system coding, colour coding and line style for HAVC System shall follow Clause 4.7 – Presentation 

Style of the BIM Guide for Building Services Installation issued by BSB, Architectural Services Department. 
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6.1.2.2 Modelling Approach of HVAC Elements and Components 

6.1.2.2.1 General 

 

All HVAC works, whether internal, external and in plant rooms, including equipment, pipework, ductwork, and 

accessories, shall be defined and created in BIM model by means of separate 3D views. The HVAC works under the 

following systems shall be grouped together for measurement: 

 Water Treatment 

 Unitary Air Conditioning System 

 Water Leakage Detection System 

 Electricity Supply 

 Control System – Automatic Control System 

 Control System – Central Control and Monitoring System 

 Air Conditioning Sundries 

 
In order to separate the quantity of the pipework/ ductwork passing through internal to plant room, the 

pipes/ ducts will be split at plant room wall for quantity take-off. The following image shows an example 

of pipework/ ductwork splitting for passing through office area to plant room. 

 

Typical HVAC Plant Room Overview 

Open Plan AC Plant Room 

Split Off 

Example of ductwork splitting for passing through plant room 
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For pipework/ ductwork, the following properties /parameters shall be provided: 

Object 

Category 

Object 

Elements 

Properties/ 

Parameters 

Fixing method 

(Parameter for QS input) 

Pipes Pipework Type and size; 

Method of jointing 

should refer to 

general 

specification/ 

particular 

specification 

Laid in ducts/ trenches/ chases, 

Embedded in in-situ concrete/ 

screeds,  

Suspended from soffits,  

Fixed to walls or columns,  

Laid on floors 

Pipe Fittings Elbow, Reducer, 

Tee, Cap 

size  

Ducts Ductwork 

rectangular in 

section 

size and type Fixed to walls and columns, 

Suspended from soffits 

Ducts Ductwork 

circular or oval 

in section 

size and type Fixed to walls and columns, 

Suspended from soffits 

Flex Duct Flexible/ 

Extensible 

ductwork 

type, size and 

length 

 

 

The naming convention of all HVAC elements shall follow Clause 4.9 – MEP Object File of the BIM Guide 

for Building Services Installation issued by BSB, Architectural Services Department. 
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6.1.2.2.2 Equipment 

 

1) All HVAC equipment shall be modelled with appropriate Mechanical Equipment category object 

elements selected. The casing of material, thermal and acoustic insulation, protective coverings and 

finishing shall be described in the Properties of related equipment. 

2) AHU/PAU/FCU/ split type A/C unit/VAV boxes/CRAC/fans and other major equipment shall be 

modelled as generic objects with overall size.  

3) All HVAC equipment should be marked with a Reference code in the Properties. 

4) The type and characteristic (e.g. power rating, cooling capacity, etc.) of HVAC equipment shall be 

stated in BIM Model as below. 

5) For each equipment, the following properties/ parameters shall be provided: 

Equipment Properties/ Parameters Fixing method 

(Parameter for QS input) 

Air handling units 

(AHU) 

type ; 

supply air flow rate ? m3/s ;  

total cooling capacity ? kW ;  

total heating capacity ? kW ; 

humidification capacity ? kg/hr steam 

 

Pump sets type ;  

water flow rate ? l/s ;  

differential static pressure ? kPa 

 

Chillers/heat pumps type ;  

cooling capacity ? kW ;  

heating capacity ? kW 

 

Fan coil units (FCU) type ; 

supply air volume flow rate ?  m3/s ;  

total cooling capacity ? kW ; 

total heating capacity ? kW 

 

Dehumidifiers type; 

flow rate ? kg/hour 

 

Ventilation fans type ; 

air flow rate ? m3/s ;  

static pressure ? kPa 

 

VAV/CAV terminal 

units 

 

type; 

number of inlets ; 

total heating capacity ? kW 
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Equipment Properties/ Parameters Fixing method 

(Parameter for QS input) 

Split package unit; 

VRV System 

type; 

total cooling capacity ? kW ; 

total heating capacity ? kW 

Ceiling mounted, 

Wall mounted, 

Floor mounted 

Single packaged air-

conditioner 

type ; 

total cooling capacity ? kW ; 

total heating capacity ? kW 
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6.1.2.2.3 Pipework 

 

 
1) All pipe elements shall be modelled as Pipes, including chilled water pipe, refrigerant pipe, etc. 

2) Pipe fittings, such as bends, elbows, tees, branches and flanges, shall be modelled as Pipe Fittings. 

3) The ancillaries including valves, strainers, and flow meters shall be modelled when necessary. 

4) The instruments like pressure gauges and thermometer shall be shown in the schematic drawings.  

5) The material and diameter for each pipe, pipe fitting and ancillaries shall be stated in the Properties. 

6) Header pipe shall be modelled as Pipes.  Details are shown in the schematic drawings. 

7) Pipework, fittings and insulation to pipework and fittings including liquid refrigerant pipes, suction 

pipes under different set of unitary air conditioning units shall be measured together irrespective of 

their sizes. The size of refrigerant/ suction pipes shall not be stated in the BIM model.  Reference 

number should be marked in the System Name parameter. 

8) Pipes passing through roofs or vertical cladding shall be modelled. 
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6.1.2.2.4 Ductwork 

 

1) All ductwork accessories shall be modelled as Duct Accessories/ Air Terminal, including air 

grilles/diffusers of various types, air ducts, silencers, louvres and dampers etc. The size and shape 

of the ductwork shall be stated in the Properties. 

2) Duct fittings including flexible connections between ducts and plants, shall be modelled as Duct 

Fittings. 

3) The ancillaries including silencers and plenums shall be modelled when necessary. The type and 

size of ancillaries shall be stated. 

4) Flexible duct shall be modelled when necessary as Flex Duct. The diameter and length shall be 

stated in the Dimensions Properties for quantity take-off. 

5) The size of duct (width and height for rectangular duct, diameter for circular duct) shall be stated to 

facilitate QTO.  

 

6.1.2.2.5 Control Panel and Switch 

 

1) Control/supervisory panel, temperature control switch, FCU speed control switch, etc. shall be 

modelled with indicative size. 
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6.1.3 Quantity Take-off 

6.1.3.1 Ductwork 

 

Ductwork taking-off plan 

Step 1:  Setup new Shared Parameters for HVAC system 

Step 2: Input the system /location filter for HVAC system 

Step 3: Create new Ductwork Schedule for HVAC system 

Step 4: Identify the area not measured in the Schedule 

Step 5:  Create other schedules e.g. air terminals, duct accessories, duct fittings and equipment, to 

measure the remaining portion. 

 

Tips: 

1. Area of Fire Damper, Volume Control Damper (VCD), Non-return Damper can be measured in Duct 

Accessory Schedule. 

2. Air grille, Supply/ Return Air Diffuser can be measured in Air Terminal Schedule. 

3. Air Silencer can be measured in the Mechanical Equipment Schedule. 

4. Insulation, protective coverings and finishing to ductwork or related fittings shall be measured the 

nett area in contact with the base of all ducting as installed and overall ducting fittings and joints 

according to the Particular Specification. 
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6.1.3.1.1 Setup new Shared Parameters for HVAC system 

 

Manage > Shared parameter  

 
 

Step 1 

Create a new Shared parameter file, e.g. HVAC.txt. 

 
 

Step 2 

Create a new Parameter group, e.g. HVAC. 
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Step 3 

Create a new Parameter, e.g. DuctLength. 

(a) Input the Name of Parameter 

(b) Select the Type of Parameter 

   
 

Step 4 

Repeat Step 3, then create the following Shared Parameter. 

(c) DuctLength, Type = Length (Measure the Length/Centerline of ductwork)  

(d) DuctGirth, Type = Length (Measure the maximum girth of ductwork) 

(e) Duct (Longer side), Type = Length (for sorting propose) 
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6.1.3.1.2 Input the System /Location filter for HVAC system  
 

1. Parameter under Identity Data can be used as 

System/ Location filter, e.g. Comments. 

2. Select all elements in the same System /Location, 

then input the data, e.g. “MV”/ “MV In Plant Room”. 

i. Select the elements by using pointer from 

right to left. 

ii. Then, refine the selected 

category by using Filter 

function.  

3. Alternatively, you may add a new project 

parameter as System/ Location filter. 

Manage > Project parameter 

Parameter Data 

 Name: Input “QTO1” / “QTO2” 

 Discipline: Common 

 Type of Parameter: Text 

 Group parameter under: Identity Data 

 Select Instance and Values are aligned per 

group type 

 Check all categories 
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6.1.3.1.3 Create new Ductwork Schedule for HVAC system 
 

Analyze > Schedule/Quantities 

 

Step 1 

Select the Category “Ducts” and Name the Schedule, e.g. Duct Schedule 

 

Step 2 

Select the fields and set formula in the Schedule. You may move the parameter up and down . 
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(a) Add parameter  Family and Type, Comments, System Type, Size, Width, Height and 

Length etc.  In this QTO, parameter Comments is adopted as System/ Location parameter.  If 

Comments is used, you may set another parameter to filter the system/ location. 

(b) Add calculated parameter  Ductwork Girth, Area, Duct (Longer side), Not exceeding 400, 

400 - 600, … , 2500 - 3000. 

 

 
 

Name Type Formula 

Ductwork Girth Length (Width + Height)*2 

Area Area Ductwork Girth*Length 

Duct (Longer side) Length if(and(Width < 400 mm, Height < 400 mm), Width, 

if(Width > Height, Width, Height)) 

Not exceeding 400 Area if(or([Duct (Longer side)] < 400 mm, [Duct (Longer 

side)] = 400 mm), Area, 0 m²) 

[A] – [B] 

e.g. 400 – 600 

600 – 800 

… 

2500 – 3000 

Area if(or(and([Duct (Longer side)] < [B] mm, [Duct 

(Longer side)] > [A] mm), [Duct (Longer side)] = 

[B] mm), Area, 0 m²) 
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(c) Set Properties 

 

 

Fields – see Step 2 above. 

Filter – filter by Comments as System, e.g. “MV” / “MV In Plant Room” 

 

 

Sorting/ Grouping – Sort the System/ Location by System Type, Comments and then click the 

“Footer” box to calculate the sub-total. 

 

Formatting – Set the Alignment, Field formatting and Show conditional format on sheets 
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e.g. Fields – “Area”/ “Width” / Height” / “Length” 

 Set the Alignment to Left /Center /Right 

 Set Field Format 

 Untick the “Use project settings” 

 Units – Square meters /Meters 

 Rounding – 2 decimal places 

 Unit symbol – m2 /m 

 Click the Show conditional format on sheets – Calculate totals, if the total of the 

parameter need to be calculated. 

  

As a result, “Ductwork Schedule” can be created, e.g. Ductwork Schedule for Mechanical 

Ventilation 

 

  

Notes: 

i) If the longer side is over 3000, then it should be measured in Number such as plenum box. 

ii) Area in Ductwork Schedule does not include the area of duct accessory, duct fitting and other 

adjustment. 
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6.1.3.1.4 Identify the area of ductwork not measured in the Ductwork Schedule 
 

Highlight the measured quantities by Filters 

View > Filters 

 

 

1. Add Filters  QTO, then select the Categories, e.g. Air Terminals, Duct Accessories, Duct 

Fittings, Ducts Systems and Ducts. 

2. Set the Filter Rules:  

 In this QTO, “Comments” parameter adopted as System/ Location filter. 

 i.e. choose the “Comments” contains/ equal to “MV”/ “MV In Plant Room” 

3. Set the pattern visible in the Model 

 

3D View : View > Visibility / Graphics  
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1. Add the aforesaid Filter “QTO”, then select the Visibility. 

2. Set the Projection/ Surface: 

 Lines set to <no override> 

 Pattern set to solid fill and select the colour 

 Transparency set to “0” 

 

The measured areas will be highlighted. 

 
 

 

Duct Accessory - 

Fire Damper 

Duct Fitting - 

Elbow 

Duct Fitting -

Transition 
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6.1.3.1.5 Create other schedules e.g. air terminals, duct accessories, duct fittings and equipment, to 

measure the remaining portion. 
 

Duct Fitting /Duct Accessory /Equipment Schedule 

Selection of scheduled fields: 

 Family and Type 

 Comments (change the title to System /Location in the Schedule) 

 System Name 

 System Type 

 Overall Size 

 Size 

 Ductwork Girth (Shared Parameter) – see below 

 DuctLength (Shared Parameter) – see below 

 Area (Calculated Value) = Ductwork Girth * DuctLength 

 

 

Set the shared parameter for each Object Type 

Select the object in the Schedule > Highlight in Model > Show > Close > Edit Family > Views (all) - Floor 

Plans - Ref. level (to check the name of Dimensions) > Family Types > Set the Shared Parameter > Load 

into Project >  
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Duct Fitting 

Object Type Shared Parameter Formula 

Elbow Ductwork Girth (Duct Width + Duct Height)*2 

DuctLength Center Radius * 2 * pi() * Angle / 360° 

Transition Ductwork Girth if((Duct Width 1 + Duct Height 1) * 2 > (Duct Width 

2 + Duct Height 2) * 2, (Duct Width 1 + Duct Height 

1) * 2, (Duct Width 2 + Duct Height 2) * 2) 

DuctLength Duct Length 

Takeoff  

(Tap – Adjustable) 

Ductwork Girth if((Duct Width 1 + Duct Height 1) * 2 > (Duct Width 

2 + Duct Height 2) * 2, (Duct Width 1 + Duct Height 

1) * 2, (Duct Width 2 + Duct Height 2) * 2) 

DuctLength Takeoff Length + Takeoff Length Projection 

Tee - Fillet Ductwork Girth if(and(Duct Width 1 > Duct Width 3, Duct Width 1 > 

Duct Width 4), (Duct Width 1 + Duct Height) * 2, 

if(Duct Width 3 > Duct Width 4, (Duct Width 3 + 

Duct Height) * 2, (Duct Width 4 + Duct Height) * 2)) 

DuctLength Duct Length 1 * 2 + Duct Length 3 

 

 

Duct Accessory 
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Object Type Shared Parameter Formula 

Fire Damper/ Fire 

and Smoke Damper 

Ductwork Girth (Height of damper + Width of damper) * 2 

DuctLength Length of damper 

Fire Damper 

Curtain Type 

Ductwork Girth (Duct Width + Duct Height) * 2 

DuctLength Damper Long 

Volume Control 

Damper /Non-return 

Damper /Motorized 

Control Damper 

Ductwork Girth (Duct Width + Duct Height) * 2 

DuctLength Damper Length 

 

Mechanical Equipment Schedule 

Object Type Shared Parameter Formula 

Silencer Ductwork Girth (Height + Width) * 2 

DuctLength Length 

 

Notes: 

i) Ductwork rectangular in section is measured over all in-line fittings, short running lengths and 

branches, i.e. the area of duct fittings shall be measured. 

ii) Where an in-line reduction in size occurs at a reducer or tee etc., the largest size shall be 

measured for the full length of the duct fittings. 

iii) In-line fittings to circular or oval ducts shall be measured extra over the ducts in which they occur, 

e.g. transformation pieces. 

iv) Total Area of Ductwork = Area of Ducts + Area of Duct Fittings + Area of Duct Accessories + Area 

of Silencer 
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6.1.3.2 Pipework 

 

Pipework taking-off plan 

Step 1:  Setup new Shared Parameters for HVAC system (Same as Ductwork) 

Step 2: Input the system /location filter for HVAC system (Same as Ductwork) 

Step 3: Create new Pipework Schedule for HVAC system 

Step 4: Identify the area not measured in the Schedule (Same as Ductwork) 

Step 5: Create other schedules e.g. pipe accessory and pipe fitting to measure the remaining portion. 

 

Tips: 

1. Refrigerant and suction pipe shall be measured in Length between outdoor unit and indoor unit, 

reference number can be found in the System Name. 

2. Header pipe shall be measured in Number.  Header pipe length shall be deducted in the pipework 

schedule. 

3. Quantity of Valves shall be counter checked with the model and the schematic drawings. 

4. Insulation, protective coverings and finishing to pipework or related fittings shall be measured 

according to the Particular Specification.   
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6.1.3.2.1 Create new Pipework Schedule for HVAC system 
 

 

Step 1 

View > Schedule > Schedule/Quantities 

 

Select the Category Pipes and Name the Schedule, e.g. Pipe Schedule 

 
 

Step 2 

Selection of scheduled fields: 

 Family and Type 

 Comments (change the title to System /Location in the Schedule) 

 System Name 

 System Type 

 Size 

 Length 

 

 

 

 

 

 

 

 

Step 3 
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Filter, Sorting/ Grouping and Formatting the Schedule 

Filter – filter by System Name as System, e.g. CHW for Chilled Water /CDP for Condensate Drain. 

 
 

Sorting/ Grouping and Formatting should reference to the Ductwork Schedule. 

 

As a result, Pipework Schedule can be created, e.g. Pipe Schedule for Chilled Water System 

 

 

Note: 

iii) Length in Pipework Schedule does not include the length of pipe accessory and pipe fitting 

and other adjustment. 
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6.1.3.2.2 Create pipe fitting and pipe accessory schedule to measure the remaining portion 
 

Pipe Fitting /Pipe Accessory 

Selection of scheduled fields: 

 Family and Type 

 Comments (change the title to System /Location in the Schedule) 

 System Name 

 System Type 

 Size 

 PipeLength (Shared Parameter) – (Same as Ductwork) 

 

Set the shared parameter for each Object Type 

Pipe Fitting 

Object Type Shared Parameter Formula 

Elbow PipeLength Center Radius * 2 * pi() * Angle / 360° 

Transition PipeLength Length 

Tee PipeLength Center to End * 3 

 

Pipe Accessory 

Object Type Shared Parameter Formula 

Gate valve PipeLength Body Length 

Balancing valve PipeLength TotalLength 

 

In Pipe Fitting and Pipe Accessory Schedule, quantities of fittings/ valves in Number can be extracted 

under the Sorting/ Grouping. 
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6.1.3.3 Equipment 

 

Equipment taking-off plan 

Step 1:  Setup new Shared Parameters for HVAC system (Same as Ductwork) 

Step 2: Input the system /location filter for HVAC system (Same as Ductwork) 

Step 3: Create new Equipment Schedule for HVAC system 

Step 4: Identify the Equipment not measured in the Schedule (Same as Ductwork) 

 

Tips: 

1. Check the required data in properties carefully. 

 

Equipment Schedule  

Step 1 

Select the Category “Mechanical Equipment” and Name the Schedule, e.g. Equipment Schedule. 

Step 2 

Selection of scheduled fields (Essential information for item description). 

             Equipment 
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Family and Type         

Reference Code         

Location         

Type         

Volume flow rate         

External Static Pressure         

Cooling capacity total load         

Heating capacity         

Water flow rate         

Pump head         

Interlock with other equipment (if any)         

Remark (if any)         
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Step 3 

Create the Equipment Schedule as aforesaid. 

 

Sample of Mechanical Equipment Schedule – Ventilation Fan 

 

 

6.1.3.4 Control and Monitoring System 

 

1) All the control panels and control points shall be measured according to the schematic drawing. 

2) Total quantities of control points/ valves/ sensors shall be checked between the model and 

schematic drawing. 
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6.2 Electrical Installation 
 

This section includes general lighting, small power and cable tray & trunking only. 

 

6.2.1 Basic Information 

6.2.1.1 Building Services Elements to Model: Electrical System 
 

The following details of Electrical (EE) System should be developed in BIM models, but not limited to: 

- LV switch board and other major equipment are modelled as generic objects with overall sizes; 

- All elements shall be modelled with appropriate System Object, include lighting fixture, lighting 

devices, electrical fixture, cable trays & trunking and fittings, etc.; 

- Details of Call Bell System are limited to locations of control/supervisory panel and the accessories; 

- MCB distribution board with number of way and rated capacity only; 

- Cable trunkings/cable trays running into/out of the plant room are modelled to verify the possible 

routing, headroom and space for maintenance; 

- Cable draw pit and earth pit with indicative size and locations only; 

- Electrical appliances, etc. with locations only. 

 

6.2.1.2 Level of Information Need (LOIN) 

 

The BIM models are to be built and created stage by stage based on the project programme. The 

recommended LOIN for individual building services object/ element at different stages shall follow the 

requirements stated in Clause 4.6 – Level of Information Need (LOIN) of the Building Information 

Modelling (BIM) Guide for Building Services Installation issued by Building Services Branch (BSB), 

Architectural Services Department. 
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6.2.2 Modelling Approach 

6.2.2.1 Modelling Process of EE BIM Model 

 

The EE model can be modelled in the manner illustrated in the following steps. 

Step 1: Creating Electrical Equipment, Lighting Fixtures, Lighting Devices and Electrical Fixture 

Choose and place the right electrical equipment, lighting fixtures, lighting devices and electrical devices 

based on the design drawing. 

 

Step 2: Cable Tray and Trunking Layout 

Step 2.1 Add cable tray and trunking to the EE system. 
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Step 2.2 Complete the EE systems with circuit. 

 

 

The system coding, colour coding and line style for EE Systems shall follow Clause 4.9 – Presentation 

Style of the BIM Guide for Building Services Installation issued by BSB, Architectural Services Department. 
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6.2.2.2 Modelling Approach of EE Elements and Components 

6.2.2.2.1 General 

 

All EE works, whether internal, external and in plant rooms, including equipment, fixtures, cable trays & trunking, 

conduits and accessories, shall be defined and created in BIM model by means of separate 3D views. The EE 

works under the following systems shall be measured: 

 Main and Sub-main Distribution 

 General Lighting and Small Power 

 Call Bell System 

 Trunking, Ladder and Tray 

 Electrical Appliances 

 Lightning Protection 

 

Category Examples 

Electrical Equipment LV Switch Board, Transformer, Emergency Generator 

Electrical Fixture Power Socket, Lightning Protection Equipment, Door Bell 

Communication Device Microphone, Speaker 

Data Device Data Outlet 

Security Device Electric Lock, Security Alarm 

Telephone Device Telephone Outlet 

Lighting Fixtures Wall, Ceiling and Recessed lights 

Lighting Device Lighting switches, Grid Switch Panel, Sensor 

 

The naming convention of all fire service elements shall follow Clause 4.11 – BIM Object File for MEP of 

the BIM Guide for Building Services Installation issued by BSB, Architectural Services Department.  
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6.2.2.2.2 Lighting Fixture and Lighting Device 

 

1) Light fittings shall be modelled with overall size and indicated with the ref. no, the upstream 

distribution board ref. (i.e. the power source), the luminaire power (i.e. watt), weatherproof rating 

(i.e. ingress protection) and essential lighting. 

2) For lighting fixture and lighting device, the following properties /parameters shall be provided: 

Object 

Category 

Object 

Elements 

Properties/ 

Parameters 

Fixing method 

(Parameter for 

QS input) 

Lighting control 

(Parameter for QS 

input) 

Lighting 

Fixture 

Luminaries/ 

Down Light/ 

Step Light/ 

Spot Light 

 

type ; size ; 

weatherproof ; 

dust proof; 

vandal resistant; 

essential lighting 

surface mounted;  

recess mounted; 

pendant mounted; 

semi-recessed 

mounted 

Local control; 

Sensor control; 

Grid switch control; 

Central control; 

Timer control; 

Contractor control 

 

Lighting 

Fixture 

LED strip light type ; size ; length ;  

? weatherproof ; 

? dust proof; 

? vandal resistant 

 

surface mounted Local control; 

Sensor control; 

Grid switch control; 

Central control; 

Timer control; 

Contractor control 

 

Lighting 

Device 

Lighting 

switches 

? A ; ?-way ;  

? gang ;  

? weatherproof  

surface mounted; 

flush mounted 

 

Lighting 

Device 

Grid switch 

panel 

? A ; ? gang ;  

? weatherproof 

surface mounted; 

 

 

Lighting 

Device 

Occupancy 

sensor 

? weatherproof ceiling mounted  

Lighting 

Device 

Photocell 

sensor 

? weatherproof ceiling mounted  
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6.2.2.2.3 Electrical Fixture 

 

1) Lightning protection equipment shall be modelled with appropriate category object elements, e.g. 

earth pit, air termination, down conductor, test joints and copper tap, etc. using the electrical fixture. 

2) For electrical fixture the following properties /parameters shall be provided: 

Object 

Category 

Object Elements Properties/ 

Parameters 

Fixing method 

(Parameter for QS input) 

Electrical 

Fixture 

Fused spur units ? A surface mounted; 

flush mounted 

Electrical 

Fixture 

Socket outlets ? A; ? gang ; 

switched/ 

unswitched 

surface mounted; 

flush mounted 

Electrical 

Fixture 

Isolator switches SPN / TPN ; ? A ; 

weatherproof 

 

surface mounted 

 

Electrical 

Fixture 

hand /face dryers 

 

 wall mounted  

 

Electrical 

Fixture 

water heaters 

 

capacity ? litres 

? kW  

 

wall mounted  

 

Electrical 

Fixture 

sweep fans/ 

sweep desk fans/ 

sweep pedestal fans 

 

m3/s speed ;  

fan blade 

diameter ? 

 

ceiling mounted; 

wall mounted  

 

Electrical 

Fixture 

domestic exhaust fans 

 

size  

 

  



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 283 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date: Dec 2023  

 

6.2.2.2.4 Cable tray and Trunking 

 

 

1) All cable tray and trunking elements shall be modelled as Cable Trays. 

2) Cable tray and trunking fittings, such as mitered elbows, bends, crosses, tees, reducers and stop 

ends, shall be modelled as Cable Tray Fittings. 

3) The size for each cable tray, trunking and the fittings shall be stated in the Properties. 

 

6.2.2.2.5 Electrical Equipment 
 

1) All EE equipment shall be modelled with appropriate Electrical Equipment category object elements 

selected. The casing of material, thermal and acoustic insulation and finishing shall be described in 

the Properties of related equipment. 

2) LVSB, MCCB and MCB distribution boards shall be modelled with overall size and indicated with 

the distribution type, the ref. name., the nos. of way and the upstream equipment ref. no. The details 

of the outgoing circuit shall refer to schematic drawings. 

3) All EE equipment should be marked with a reference code in the Properties. 
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6.2.3 Quantity Take-off 

6.2.3.1 Lighting Fixture Schedule 

 

Step 1 

View > Schedule > Schedule/Quantities 

Select the Category Lighting Fixture and selection of scheduled fields: 

- Family 

- Type 

- Count 

- Lighting Fitting ref. No. 

- Power Source 

- Lighting Control (Shared Parameter; input by QS) 

 

In lighting fixture schedule, quantities of light fittings in number can be extracted under the Sorting/ 

Grouping. 
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For strip lighting measured in length can be extracted under the Sorting/ Grouping. 

 
 

6.2.3.2 Lighting Device Schedule 

 

Step 1 

View > Schedule > Schedule/Quantities 

Select the Category Lighting Device and selection of scheduled fields: 

- Family  

- Type 

- Count 

 

In lighting devices Schedule, quantities of devices in number can be extracted under the Sorting/ 

Grouping. 
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6.2.3.3 Electrical Fixture Schedule 

 

Step 1 

View > Schedule > Schedule/Quantities 

Select the Category Electrical Fixtures and selection of scheduled fields: 

- Family 

- Type 

- System Category 

- Comments 

- Count 

- Power Source 

 

Step 2 

Filter – filter by System Category 

 

In electrical fixture Schedule, quantities of the devices in number can be extracted under the Sorting/ 

Grouping. 
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6.2.3.4 Cable Tray and Trunking 

 

Cable Tray/Trunking taking-off plan 

Step 1:  Setup new Shared Parameters for Cable Tray/Trunking (Same as Ductwork) 

Step 2: Input the system /location filter for Cable Tray/Trunking (Same as Ductwork) 

Step 3: Create new Pipework Schedule for Cable Tray/Trunking 

Step 4: Identify the area not measured in the Schedule (Same as Ductwork) 

Step 5: Create other schedules e.g. cable tray/trunking fitting to measure the remaining portion. 

 

6.2.3.4.1 Create new Cable Tray/Trunking Schedule 
 

Step 1 

View > Schedule > Schedule/Quantities 

 

Select the Category Cable Trays and Name the Schedule, e.g. Cable Tray and Trunking Schedule. 
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Step 2 

Selection of scheduled fields: 

 Family and Type 

 System Category 

 Bottom Elevation 

 Comments (change the title to System /Location in the Schedule) 

 Size 

 Width 

 Height 

 Length 

 

 

 

 

 

 

Step 3 

Filter, Sorting/ Grouping and Formatting the Schedule 

Filter – filter by Bottom Elevation as Direction of cable tray/trunking, e.g. 0 for vertical cable tray/trunking, 

>0 for horizontal cable tray/trunking 
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Sorting/ Grouping – sort by Family and Type, System Category, Size and then click the “Footer” box to 

calculate the sub-total. 

 

 

Formatting - calculate totals for the Length 
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As a result, Cable Tray and Trunking Schedule can be created, e.g. Cable Tray and Trunking 

Schedule (Horizontal). 

  

Note: 

i) Length in Cable Tray and Trunking Schedule does not include the length of cable tray and 

trunking fittings and other adjustment. 
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6.2.3.4.2 Create cable tray and trunking fitting schedule to measure the remaining portion 
 

Cable Tray and Trunking Fitting 

Selection of scheduled fields: 

 Family and Type 

 Comments (change the title to System /Location in the Schedule) 

 System Category 

 Size 

 Cable Tray Length (Shared Parameter) – (Same as Ductwork) 

 

Set the shared parameter for each Object Type 

Cable Tray and Trunking Fitting 

Object Type Shared Parameter Formula 

Mitered Elbow Cable Tray Length 2*tan(Angle / 2) * Width / 2 + Shoulder 

Bend Cable Tray Length 
2π * Bend Radius Label * (Angle / 360°) 

Cross Cable Tray Length 2 * Cross Straight Length 

Tee Cable Tray Length Tee Straight Length + Tee-out Length 

Reducer Cable Tray Length Tray Length 

 

In Cable Tray Fitting Schedule, quantities of fittings in Number can be extracted under the Sorting/ 

Grouping. 
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6.2.3.5 Electrical Equipment Schedule 

 

In Electrical Equipment Schedule, quantities of equipment in number can be extracted under the 

Sorting/ Grouping. 
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6.3 Fire Service Installation 

6.3.1 Basic Information 

6.3.1.1 Building Services Elements to Model: Fire Service System 

 

The following details of fire service system should be developed in BIM models, but not limited to: 

- All elements shall be modelled with appropriate System Object, including fire sprinkler heads, fire 

alarm devices, fire services pipes, etc. 

- Control panels, fire alarm switches, control valves, etc. with indicative size and locations only. 

- Pipes running into/out of the plant room are modelled to verify the possible routing, headroom, 

and space for maintenance. 

- Fire pumps, fire pump control panels, and other major equipment are modelled with overall sizes 

and positions of connections. 

 

6.3.1.2 Level of Information Need (LOIN) 

 

The BIM models are to be built and created stage by stage based on the project programme. The 

recommended LOIN for individual building services object/ element at different stages shall follow the 

requirements stated in Clause 4.6 – Level of Information Need (LOIN) of the Building Information 

Modelling (BIM) Guide for Building Services Installation issued by Building Services Branch (BSB), 

Architectural Services Department. 
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6.3.2 Modelling Approach 

6.3.2.1 Modelling Process of Fire Service BIM Model 

 

The fire service BIM model can be modelled in the manner illustrated in the following steps. 

 

Step 1: Creating Fire Service Equipment, Fire Alarm Device and Sprinkler 

 

Select and place the appropriate fire service pumps, fire alarm devices and fire sprinklers heads based 

on the design location. 

 

 

Step 2: Pipe Layout 

 

Step 2.1 Complete the fire service systems with pipes and pipe accessories. 
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Step 2.2 Change the colour of different types of fire service equipment and pipes. 

 
 

The system coding, colour coding and line style for fire service system shall comply with Clause 4.9 – 

Presentation Style of the BIM Guide for Building Services Installation issued by BSB, Architectural 

Services Department. 
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6.3.2.2 Modelling Approach of Fire Service Elements and Components 

6.3.2.2.1 General 

 

All fire service works, whether internal, external and in plant rooms, including equipment, fire services 

devices, pipework, and accessories, shall be defined and created in BIM model by means of separate 3D 

views. The fire service works under the following systems shall be grouped together for measurement: 

- Hydrant and hose reel system; 

- Automatic sprinkler system; 

- Pre-action system; 

- Drencher system; 

- Gaseous extinguishing system; 

- Manual and automatic fire alarm system; 

- Portable hand-operated accepted appliances; 

- Fire alarm control system; 

- Associated electrical installation; 

- Exit sign, directional sign and emergency generator  

 

In order to separate the quantity of the pipework passing through internal wall to plant room, the pipes 

should be split at plant room wall for quantity take-off.  

 
 

The naming convention of all fire service elements shall follow Clause 4.11 – BIM Object File for MEP of 

the BIM Guide for Building Services Installation issued by BSB, Architectural Services Department.  

 

Split Off 

Plant Room 

Example of pipework splitting for passing through plant room 
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6.3.2.2.2 Pipework 

 

 

1) All pipe elements shall be modelled as Pipes, including hose reel pipe, sprinkler pipe, etc. 

2) Pipe fittings, such as bends, elbows, tees, branches and flanges, shall be modelled as Pipe Fittings. 

3) The ancillaries including valves, strainers, and flow meters shall be modelled when necessary. 

4) The instruments like pressure gauges and thermometer shall be shown in the schematic drawings. 

5) The material and diameter for each pipe, pipe fitting and ancillaries shall be stated in the Properties. 

6) Header pipe shall be modelled as Pipes. Details are shown in the schematic drawings. 

7) Pipes passing through roofs or vertical cladding shall be modelled. 

8) For pipework, the following properties / parameters shall be provided: 

Object 

Category 

Object 

Elements 

Properties/Parameters Fixing method  

(Parameter for QS input) 

Pipes Pipework Type and size; 

Method of jointing should 

refer to general 

specification / particular 

specification 

 

Laid in trenches / chases,  

Embedded in in-situ concrete / screeds, 

Suspended from soffits,  

Fixed to walls or columns, 

Laid on floors 

Pipe 

Fittings 

 

Elbow, Reducer, 

Tee, Cap 

Size  
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6.3.2.2.3 Fire Service Equipment, Sprinkler and Fire Alarm Device 

 

1) All fire service equipment, sprinklers and fire alarm devices shall be modelled with appropriate fire 

service equipment object category selected.  

2) All fire service equipment should be marked with a reference code in the Properties. 

3) The type and characteristic of fire service equipment, sprinkler and fire alarm device shall be stated 

in BIM model. 

4) For each equipment, sprinkler and fire alarm device, the following properties/ parameters shall be 

provided: 

Object 

Category 

Equipment/ 

Sprinklers/ 

Fire Alarm Devices 

Properties/ 

Parameters 

Fixing method 

(Parameter for QS input) 

Mechanical 

Equipment 

Pump set type ;  

water flow rate ? l/s ;  

differential static 

pressure ? kPa ; 

ref. no 

 

 

Fire Alarm 

Device 

Pump control panel panel type; 

 

 

Fire Alarm 

Device 

Fire alarm control and 

indicating panel 

 

panel type ; 

 

 

Sprinkler Sprinkler/ Sprinkler 

head 

type ; Pendant,  

Upright,  

Side wall,  

Flush pattern pendant type 

Fire Alarm 

Device 

Break glass unit 

 

type ; 

 

Surface mounting, 

Semi-recessed mounting 

Fire Alarm 

Device 

Heat/ Smoke detector type ;  Pendant mounting, 

Surface mounting, 

Semi-recessed mounting 

Fire Alarm 

Device 

Remote alarm 

indicator lamps 

type ; Ceiling mounting, 

Door mounting 
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Object 

Category 

Equipment/ 

Sprinklers/ 

Fire Alarm Devices 

Properties/ 

Parameters 

Fixing method 

(Parameter for QS input) 

Fire Alarm 

Device 

Flashing light 

 

type ; Surface mounting, 

Semi-flush mounting 

Fire Alarm 

Device 

Fire alarm bell type ; 

size 

 

Fire Alarm 

Device 

Fire Hydrant 

 

type ;  Housed in cabinet 

Fire Alarm 

Device 

Fire services inlet/ 

Sprinkler inlet 

type ; 

 

Housed in cabinet 

Fire Alarm 

Device 

Hose Reel 

 

type ; 

 

Housed in cabinet 

Fire Alarm 

Device 

Fire Extinguisher type ; 

capacity 

 

Wall mounted, 

Housed in cabinet 

 

6.3.3 Quantity Take-off 

6.3.3.1 Pipework 

 

Pipework taking-off plan 

Step 1:  Setup new Shared Parameters for fire service system 

Step 2: Input the system /location filter for fire service system 

Step 3: Create new Pipework Schedule for fire service system 

Step 4: Identify the area not measured in the Schedule 

Step 5: Create other schedules e.g. pipe accessory and pipe fitting to measure the remaining portion. 

 

Tips: 

1. Header pipe shall be measured in Number. Header pipe length shall be deducted in the pipework 

schedule. 

2. Quantity of valves shall be counter checked with the model and the schematic drawings. 
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6.3.3.1.1 Create new Pipework Schedule for Fire Service System 
 

Step 1 

View > Schedule > Schedule/Quantities 

 

Select the Category Pipes and Name the Schedule, e.g. Pipe Schedule 

 

 

 

Step 2 

Selection of scheduled fields: 

- Family 

- Type 

- Reference Level 

- System Name 

- System Type 

- Comments (change the title to System /Location in the Schedule) 

- Size 

- Length 
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Step 3 

Filter, Sorting/ Grouping and Formatting the Schedule 

Filter – filter by System Name* as System, e.g. SPR for Sprinkler / FSP for Fire Service Pipe 

 

*Cannot filter System Type 

 

Sorting/ Grouping and Formatting for Pipework Schedule should refer to the Ductwork Schedule in 

Section 6.1.3.1, which therefore can be created, e.g. Pipe Schedule for Fire Service System 

 

Note: 

i) Length in Pipework Schedule does not include the length of pipe accessory and pipe fitting 

and other adjustment.  
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6.3.3.1.2 Create pipe fitting and pipe accessory schedule to measure the remaining portion 
 

Pipe Fitting /Pipe Accessory 

Selection of scheduled fields: 

- Family and Type 

- Count 

- System Name 

- System Type 

- Comments (change the title to System /Location in the Schedule) 

- Size 

- PipeLength (Shared Parameter) 

 

Set the shared parameter for each Object Type 

Pipe Fitting 

Object Type Shared Parameter Formula 

Elbow PipeLength Center Radius * 2 * pi() * Angle / 360° 

Transition PipeLength Length 

Tee PipeLength Center to End * 3 

 

Pipe Accessory 

Object Type Shared Parameter Formula 

Gate valve PipeLength Body Length 

 

In Pipe Fitting and Pipe Accessory Schedule, quantities of fittings/ valves in Number can be extracted 

after sorting/grouping.  
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6.3.3.2 Fire Service Equipment, Sprinkler and Fire Alarm Device 

 

Equipment, Sprinkler and Fire Alarm Device taking-off plan 

Step 1:  Setup new Shared Parameters for fire service system 

Step 2: Input the system /location filter for fire service system 

Step 3: Create new equipment schedule for fire service system 

Step 4: Identify the equipment not measured in the schedule 

 

Tips: 

1. Check the required data in properties carefully. 

 

Equipment, Sprinkler and Fire Alarm Device Schedule  

Step 1 

Select the object Category and Name the Schedule, e.g. Sprinkler Schedule. 

Step 2 

Selection of scheduled fields (Essential information for item description). 

 

Equipment/ 

Sprinkler/ 

Fire Alarm  

Devices 

 

Fields Fi
re

 S
er

vi
ce

 / 
Sp

rin
kl

er
 

Pu
m

p 

Sp
rin

kl
er

 

Fi
re

 H
yd

ra
nt

 

H
os

e 
R

ee
l U

ni
ts

 

Fi
re

 A
la

rm
 D

ev
ic

e 

Po
rta

bl
e 

Fi
re

 E
xt

in
gu

is
he
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Family and Type      

Level      

Type      

Assembly Code      

Volume flow rate      

External Static Pressure      

Water Flow Rate      

Pump Head      
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Step 3 

Create the Fire Alarm Devices Schedule as aforesaid. 

 

6.3.3.3 Control and Monitoring System 

 

1) All the control panels and control points shall be measured according to the schematic drawing. 

2) Total quantities of control points/ valves/ sensors shall be checked between the model and 

schematic drawing.  
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6.4 Above Ground Plumbing and Drainage Works 
6.4.1 Basic Information 

6.4.1.1 Building Services Elements to Model: Above Ground Plumbing (WS) and Drainage (SD) System 

 

The following details of Above Ground Plumbing and Drainage (WS&SD) System should be developed in 

BIM models, but not limited to: 

- All elements shall be modelled with appropriate System Object, include pipes and fittings, 

ancillaries, equipment, fixture, etc.; 

- Pump sets are modelled as mechanical equipment with water flow rate and pump head; 

- Pressure vessels are modelled as mechanical equipment with capacity; 

- Water tank and sanitary fittings with types and locations only; 

- Water meter with locations only; 

- Ball float valve, loose jumper valve and check meter with diameter only; 

- Floor drain and planter drain with type and diameter of pipe only; 

- Wire balloon grating with diameter of pipe only; 

- Control/supervisory panel, etc. with indicative size and locations only. 

 

6.4.1.2 Level of Information Need (LOIN) 

 

The BIM models are to be built and created stage by stage based on the project programme. The 

recommended LOIN for individual building services object/ element at different stages shall follow the 

requirements stated in Clause 4.6 – Level of Information Need (LOIN) of the Building Information 

Modelling (BIM) Guide for Building Services Installation issued by Building Services Branch (BSB), 

Architectural Services Department. 
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6.4.2 Modelling Approach 

6.4.2.1 Modelling Process of WS&SD BIM Model 

 

The WS&SD BIM model can be modelled in the manner illustrated in the following steps. 

 

Step 1: Creating WS&SD Fixtures/Equipment 

Select and place the right WS&SD fixtures/equipment based on the design drawing. 

 

 

Step 2: Pipes Layout 

Step 2.1 Complete the WS&SD systems with pipes. 
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Step 2.2 Change the colour of different types of fixtures/equipment and pipes. 

 
 

The system coding, colour coding and line style for WS&SD system shall comply with Clause 4.9 – 

Presentation Style of the BIM Guide for Building Services Installation issued by BSB, Architectural 

Services Department. 
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6.4.2.2 Modelling Approach of Above Ground Plumbing and Drainage Elements and Components 

6.4.2.2.1 General 

 

All above ground plumbing and drainage works, whether internal, external and in plant rooms, including 

equipment, pipework, and accessories, shall be defined and created in BIM model by means of separate 

3D views. The above ground plumbing and drainage works under the following systems shall be measured: 

- Cold water system; 

- Hot water system; 

- Flushing water system; 

- Cleansing water system; 

- Irrigation water system; 

- Rainwater harvesting system; 

- Electricity supply system; 

- Control system; 

- Sanitary fittings; 

- Soil, waste, ventilation and rainwater system. 

 

In order to separate the quantity of the pipework passing through  

(i) internal wall to plant room; or 

(ii) from aboveground to underground;  

the pipes should be split at plant room wall/ on grade slab for quantity take-off.  

 

 

 

The naming convention of all above ground plumbing and drainage elements shall follow Clause 4.11 – 

BIM Object File for MEP of the BIM Guide for Building Services Installation issued by BSB, Architectural 

Services Department.  

Split Off 

Underground 

Example of pipework splitting for passing through on grade slab 
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6.4.2.2.2 Equipment/ Fixture 

 

1) All above ground plumbing and drainage equipment/fixture shall be modelled with appropriate 

above ground plumbing and drainage equipment/fixture category object elements selected. The 

casing of material, thermal insulation and finishing shall be described in the Properties of related 

equipment. 

2) All above ground plumbing and drainage equipment/fixture should be marked with a reference code 

in the Properties. 

3) The type and characteristic of above ground plumbing and drainage equipment/fixture shall be 

stated in BIM model. 

4) For each equipment, the following properties/ parameters shall be provided: 

Object 

Category 

Equipment Properties/ Parameters 

Mechanical 

Equipment 

Pump set type ;  

water flow rate ? l/s ;  

differential static pressure ? kPa 

Mechanical 

Equipment 

Pressure vessel water system ; 

capacity 

5) For each fixture, the following properties/ parameters shall be provided: 

Object 

Category 

Fixture Properties/ Parameters 

Plumbing 

Fixture 

Sanitary fitting* type ; 

location 

Plumbing 

Fixture 

Fibreglass water 

tank 

location only 

 

* Type and Quantity of sanitary fittings shall be counter checked with the architectural model. 
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6.4.2.2.3 Pipework 

 

 

1) All pipe elements shall be modelled as Pipes, including cold water pipe, hot water pipe, flushing 

water pipe, etc. 

2) Pipe fittings, such as bends, elbows, tees, branches and flanges, shall be modelled as Pipe Fittings. 

3) The ancillaries including valves, loose jumper stop cocks, strainers, meters, drains/outlets and 

gratings shall be modelled when necessary. 

4) The material and diameter for each pipe, pipe fitting and ancillaries shall be stated in the Properties. 

5) Header pipe shall be modelled as Pipes. Details are shown in the schematic drawings. 

6) Pipes passing through roofs or vertical cladding shall be modelled. 

7) For pipework, the following properties / parameters shall be provided: 

Object 

Category 

Object Elements Properties/Parameters Fixing method  

(Parameter for QS input) 

Pipes Pipework Type and size; 

Method of jointing should 

refer to general 

specification / particular 

specification 

Laid in trenches / chases, 

Embedded in in-situ concrete 

/ screeds,  

Suspended from soffits,  

Fixed to walls or columns, 

Laid on floors 

Pipe 

Fittings 

Elbow, Reducer, 

Tee, Cap 

Size  
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8) For pipework ancillaries, the following properties / parameters shall be provided: 

Object Category Object Elements Properties/Parameters 

Pipe Accessory  Ball float valve diameter 

Pipe Accessory  Loose jumper valve diameter 

Pipe Accessory  Water meter location only 

Pipe Accessory  Check meter diameter 

Pipe Accessory  Floor drain type ; 

diameter of pipe 

Pipe Accessory  Planter drain type ; 

diameter of pipe 

Pipe Accessory  Wire balloon grating diameter of pipe 

 

6.4.2.2.4. Control Panel 

1)  Control/supervisory panel, etc. shall be modelled with indicative size. 
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6.4.3 Quantity Take-off 
6.4.3.1 Pipework 

 

Pipework taking-off plan 

Step 1:  Setup new Shared Parameters for above ground plumbing and drainage system 

Step 2: Input the system /location filter for above ground plumbing and drainage system 

Step 3: Create new Pipework Schedule for above ground plumbing and drainage system 

Step 4: Identify the area not measured in the Schedule 

Step 5: Create other schedules e.g. pipe accessory and pipe fitting to measure the remaining portion. 

 

Step 1, 2 and 4 refer to the Ductwork Schedule in Section 6.1.3.1 

 

Tips: 

1. Header pipe shall be measured in Number. Header pipe length shall be deducted in the pipework 

schedule. 

2. Quantity of valves shall be counter checked with the model and the schematic drawings. 

3. Insulation, protective coverings and finishing to pipework or related fittings shall be measured 

according to the Particular Specification. 
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6.4.3.1.1 Create new Pipework Schedule for Above Ground Plumbing and Drainage system 
 

Step 1 

View > Schedule > Schedule/Quantities 

 

Select the Category Pipes and Name the Schedule, e.g. Pipe Schedule 

 
 

Step 2 

Selection of scheduled fields: 

 Family 

 Type 

 Comments (change the title to System /Location in the Schedule) 

 System Type 

 System Abbreviation 

 Material 

 Size 

 Length 
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Step 3 

Filter, Sorting/ Grouping and Formatting the Schedule 

Filter – filter by System Abbreviation* as System, e.g. FLWP for Flushing Water Pipe / CLWP for 

Cleansing Water Pipe / WP for Waste Pipe / RWP for Rainwater Pipe / SWP for Soil and Waste Pipe, 

etc. 

  

*Cannot filter System Type 

 

Sorting/ Grouping and Formatting for Pipework Schedule should refer to the Ductwork Schedule in 

Section 6.1.3.1, which therefore can be created, e.g. Pipe Schedule for Soil and Waste System 

 

 
Note: 

i) Length in Pipework Schedule does not include the length of pipe accessory and pipe fitting 

and other adjustment.  
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6.4.3.1.2 Create pipe accessory and pipe fitting schedule to measure the remaining portion 
 

Pipe Fitting /Pipe Accessory 

Selection of scheduled fields: 

 Family 

 Type 

 Comments (change the title to System /Location in the Schedule) 

 System Type 

 System Abbreviation 

 Size 

 PipeLength (Shared Parameter) – (Same as Duckwork) 

 

Set the shared parameter for each Object Type 

Pipe Fitting 

Object Type Shared Parameter Formula 

Elbow PipeLength Center Radius * 2 * pi() * Angle / 360° 

Transition PipeLength Length 

Tee PipeLength Center to End * 3 

 

Pipe Accessory 

Object Type Shared Parameter Formula 

Gate valve PipeLength Body Length 

Check valve PipeLength Body Length 

Strainer PipeLength Strainer Length 1 

Flexible Connectors PipeLength if(Diameter > 200 mm, if(Diameter > 500 

mm, 254 mm, 203 mm), 152 mm) 

 

In Pipe Fitting and Pipe Accessory Schedule, quantities of fittings/ valves in Number can be extracted 

under the Sorting/ Grouping.  
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6.4.3.2 Equipment/Fixture 

 

Equipment/Fixture taking-off plan 

Step 1:  Setup new Shared Parameters for above ground plumbing and drainage system  

Step 2: Input the system /location filter for above ground plumbing and drainage system  

Step 3: Create new Equipment/Fixture Schedule for above ground plumbing and drainage system 

Step 4: Identify the Equipment/Fixture not measured in the Schedule  

 

Tips: 

1. Check the required data in properties carefully. 

 

Equipment Schedule  

Step 1 

Select the Category “Mechanical Equipment” and Name the Schedule, e.g. Pump Set Schedule. 

Step 2 

Selection of scheduled fields (Essential information for item description). 

 Family and Type 

 System Name 

 System Classification  

 Comments 

 Level  

 Water Flow Rate (L/S) 

 Pump Head (m) 

 Count 

 

Step 3 

Create the Equipment Schedule as aforesaid. 

Sample of Above Ground Plumbing and Drainage Equipment Schedule – Pump Set and Pressure 

Vessel Schedule 
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Plumbing Fixture 

Step 1 

Select the Category “Plumbing Fixture” and Name the Schedule, e.g. Plumbing Fixture Schedule. 

Step 2 

Selection of scheduled fields (Essential information for item description). 

 Family 

 Type 

 System Classification  

 System Name 

 Comment (change the title to System /Location in the Schedule) 

 Count 

 

Step 3 

Create the Plumbing Fixture Schedule as aforesaid. 

Sample of Above Ground Plumbing and Drainage Fixture Schedule – Plumbing Fixture Schedule 

 

 

 

 

 

 

 

6.4.3.3 Control and Monitoring System 

 

1) All the control panels, control points and MCB distribution boards shall be measured according to 

the schematic drawing. 

2) Total quantities of control points/ valves/ sensors shall be checked between the model and 

schematic drawing. 
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6.5 Underground Drainage Works 
 

6.5.1 Basic Information 

6.5.1.1 Building Services Elements to Model: Underground Drainage System 

 

The following details of underground drainage should be developed in BIM models, but not limited to: 

- Manholes; 

- Sump Pit; 

- Sealed Trapped Gully (STG) (i.e. Back Inlet Gully Trap (BIGT); 

- Open Trapped Gully (OTG); 

- Rain Water Outlet (RWO); 

- Gully Trap (GT); 

- Drainage pipes; 

- Drainage pipe fittings and  

- Surface channel 

 

The followings are the general principles should be adopted when assembling an Underground Drainage 

Building Information Model: 

1) The following elements are to be excluded from general BIM underground drainage model: 

a. Concrete surrounding/ bedding of pipes. 

2) To facilitate the linking of individual sub-model to a building model at later stages, modeller should 

adopt the following practices when making the sub-models. 

 The locations and orientations of all sub-models should refer to the same origin. 

 Select "Auto - By Shared Coordination" for Positioning during the linking sub-model process. 
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3) All elements should be specified with the designed construction material (i.e. concrete for manholes, 

OTG, STG and ductile iron/ precast concrete for pipes). 

4) All objects should include data such as pipe material, basic dimensions, type no. etc. which can be 

extracted for quantity takeoff purpose. 

5) For tender stage drawings production process, all underground drainage pipes should be shown in 

single line. 

 

6.5.1.2 Sequence of Modelling 

 

The sequence of modelling: 

 Step 1: Drainage fixture (incl. Manholes, STG, OTG, sump pit etc.);  

 Step 2: Pipework. 
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6.5.2 Modelling Approach 

6.5.2.1 Modelling Process of Underground Drainage Fixtures (Manholes, Sump Pits, BIGT, OTG) 

 

1) Manhole, Sump Pit, Sealed Trapped Gully (STG), Open Trapped Gully (OTG) element shall be 

modelled as a Plumbing Fixtures model category. 

2) Drainage fixtures shall be created as a Loadable object. The objects shall be built based on the 

standard drawing provided by the Drainage Services Department or designers' drawing details. 

3) The variable dimension shall be labelled as a parameter in the objects in order to control the 

dimensions of the fixtures. 

4) The "Offset" is the actual level of the manholes/pits. 

5) The following sharable parameters have to be added to the (a) manhole object and (b) drainage 

fixtures other than manholes such that they can provide relevant information for other model users or 

element annotating: 

 
Parameter Type/ Instance Description Manhole 

object 
 

(a) 

Other 
drainage 
fixtures 

(b) 
Manhole Number Instance Manhole number  

Cover Level Instance Cover level of manhole  

Invert Level Instance Invert level of manhole  

Manhole Width Instance Width of manhole  

A1 to A9 Instance The incoming pipe invert 
level counting clockwise 
from outgoing pipe 

* 

Outlet Pipe Size Instance Nominal diameter of 
outlet pipe 

* 

    

*  Add parameter for QS input 
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Manhole Properties 

 

*  Add parameter for QS input 

 

6.5.2.2 Modelling Process of Pipework 

 

1) All underground drainage pipes should be modelled, include subsoil drain, waste pipe, soil and waste 

pipe, vent pipe, pumped waste pipe etc. 

2) Pipe segments shall be applied to all pipes to differentiate different pipe system.  Each pipe segment 

includes a material and schedule/ type combination a roughness, and a range of sizes. 

3) Pipe fittings such as bend, branches and gully trap shall be modelled. 

  

(1) Reference level 

(2) Actual level 

(3) Manhole number 

(4) Cover level 
(5) Invert level 
(6) Width of Manhole 

*(7) Incoming pipe invert level 

*(8) Nominal diameter of outlet pipe 
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4) The material, inner and outer diameter for each pipe, pipe 

fitting and ancillaries shall follow the specification of 

underground drainage system and stated in the Properties. 

 
 

 
5) Unless shown otherwise, underground drains or sewers shall be laid to fall as follows. 

PIPE DIA. (mm) FALL* 
100 1 to 40 
150 1 to 70 
200 1 to 100 
225 1 to 100 
250 1 to 120 
300 1 to 150 
350 1 to 170 
400 1 to 200 
450 1 to 210 

 * For indication only, the exact value should be depended on site condition. 

6) The 'Start offset' is the actual start level of the pipe and the 'End offset' is the actual end level of the 

pipe.  

7) Start and end of underground drainage pipes should align with inner wall of drainage fixtures. 

8) The running length of pipes (mm) is calculated for quantity extraction. 

9) The diameter of pipes shall be added for quantity extraction. 

  

Pipe Type Setting Pipe Segment and Sizes 
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6.5.3 Quantity Take-off 

6.5.3.1 Manholes and the like 

 

1. Number of Manholes can be measured in Plumbing Fixtures Schedule under Piping Category.  In 

rare case, some drainage equipment may be measured in Mechanical Equipment Schedule under 

Mechanical Category. 

 

2. Manhole Depth shall be calculated between the cover level and the invert level by inserting a 

calculated parameter.  It shall be grouped in (1) not exceeding 1.0m; and (2) thereafter in 0.50m 

stages.  
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6.5.3.2 Drain pipes 

 

1. Drain pipes can be measured in Pipes Schedule under Piping Category. 

 
2. Drain pipes shall be measured along the centerline of pipes over all bends, junctions and other 

pipe fittings in meter (m) run.  It shall be measured to inside surfaces of manholes and 

accessories. 
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7. Techniques for Quantity-Take-Off (QTO) 

7.1 Open a Model 
 

 when you open a model file, you can detach the local model from a central workshared model (open 

a model independently for whom want to see changes or make changes without saving them). 

 

Open a Workshared Project Independent of the Central Model 

Step 1 

On the Home page, under Models, click Open. 

or 

Go to File tab  Click Open   (Project). 

 

Step 2 

In the Open dialog, navigate to the folder where the model resides  Select the Model  Select 

Detach from Central  Click Open 

 

 

Step 3 

Detach and preserve worksets 

 

After open the project, it no longer has any path or permissions information, and the default file name is 

the original filename with "_detached" appended. The project is in a state similar to when worksharing 

was first enabled; all elements in the project can be modified, but no changes can be saved back to the 

central model. If you save the project, it is saved as a new central model. 
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7.2 Shared Parameters 
 

 use shared parameters to add specific data which is not yet defined in object file or project template.  

 can be used in multiple objects and projects. 

 stored in a file independent of any object file or project. 

 

Create a Shared Parameters 

Step 1 

To set up the shared parameters:  

Go to Manage Tab  Setting panel  Click Shared Parameters (1)  In the Edit Shared Parameters 

dialog, click Create (2) 

 

 

 

Step 2 

In the Edit Shared Parameters dialog, you can (3) create a Parameter group and (4) add new 

parameters in Parameter group. 

  

(1) 

(2) 

(4) 

(3) 
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Step 3 

For creating new Parameter Group:  

In Groups Tab, Click New  Add group name  

      

 

Step 4 

For creating new Parameters in Parameter Group: 

In Parameter Tab, Click New  Add Parameter name  Choose Discipline and Type of Parameter* 

    

*Please confirm the Type of Parameter to create new 

parameters. 

 

* 
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7.3 Project Parameters 
 

 can be added to categories of elements in a project, and used in schedules.  

 cannot be shared with other projects or objects. 

 

Create a Project Parameters 

Step 1 

To add the project parameter in the project:  

Go to Manage Tab  Setting panel  Click Project Parameters (1)  In the Edit Project Parameters 

dialog, click Add 

 

 
 

Step 2 

In the Edit Parameter Properties dialog, you can (1) create a new Project parameter by input Name, select 

related Discipline, Type of Parameter and Group parameter under: or (2) add the created Shared 

parameter as details in 4.1. 

 
 

(1) 

(2) 

(1) 

(3) 
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Step 3 

Check the related Categories (3). 

 

Step 4 

Select Type or Instance in the Parameter Data. 

Type: Enable to modify the parameter value to all elements of the object type. 

Instance: Enable to modify the parameter value separately for every instance. 

  Values are aligned per group type: 

 If an element with this instance parameter is part of multiple groups, the 

parameter value will be the same for corresponding elements in all group 

instances. While in Edit Group mode, you can select the element and modify 

the parameter on the Properties palette. Changing the parameter value for 

the element in one group will change the value for the corresponding 

element in all other instances of the same group type. 

  Values can vary by group instance: 

 If the element with this instance parameter is part of multiple groups, the 

parameter value can vary for corresponding elements in group instances. 

While in Edit Group mode, you can select the element and modify the 

parameter on the Properties palette. Changing the parameter value for the 

element in one group will not change the value for the corresponding 

element in other instances of the same group type. 

 

Step 5 

Click OK to add the parameters into project. 
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7.4 Schedule/ Material Takeoff 
 

Two helpful functions under Schedules for QTO: 

Schedule/Quantities – for extraction of general information except material information. 

Material Takeoff  – possess all the functions and characteristics of schedule views, but allow to 

get material quantities such as paint area. 

 

Create a Schedule/ Material Takeoff 

Step 1 

Go to View Tab  Click Schedule (1)  Click Schedule /Quantities or Material Takeoff (2) 

 

 

 

 

Step 2 

In the New Schedule/ New Material Takeoff dialog, click a category for the material takeoff schedule (for 

taking-off different elements, you can choose <Multi-Category>) 

 

(1) 

(2) 

(2) 
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Step 3 

Type the name into the Name field  make sure the Phase is New Construction 

 

 

Step 4 

Fields: 

(a) To customize the schedule, “Add” the required fields from Available fields to Scheduled fields: 

(3) Select parameter in Available fields box  Click 

 

(3) 

(4) 
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(b) Add the parameters in schedule: 

Click “Add Parameter” (4)  Pick Share Parameter  Click Select (5)  Choose a parameter 

group, and a parameter  Click OK 

 
 

(c) Calculated Value in schedule: 

Click “Calculated Value” (6) Add Name and Choose Type  Use Selected Parameter to create 

Formula  Click OK 

 

 

(5) 

(6) 
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Step 5 

Filter: 

(a) Use the filter to specify which material(s) you want to show into the schedule or limit the display of 

data in the schedule. (e.g. Level) 

 

 

Step 6 

Sorting/Grouping: 

(a) Choose the properties, if you would like the schedule are sorting by 
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(b) Click the option Grand totals, if you would like itemize every instance 

On the Sorting/Grouping tab  Click Ground Total (7)  Select option 

 
 

Step 7 

Formatting: 

(a) If the option Grand totals clicked, also click the option Calculate totals in area / volume properties 

fields 

 

(7) 

(8) 
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(b) Specify various formatting options, such as column orientation and alignment, grid lines, borders, 

and font styles. 

Click Conditional Format (8)  Add rule  Set Background Color  

 
 

Step 8 

You can change the setting at properties window to modify the schedule. 
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Step 9 

Schedule/ Materials Take-off can be exported as a text file and copied to Excel for further manipulation 

or can be exported to Excel by plug-in software. 

(a) Go to File tab > Export > Reports > Schedule 

 

 
(b) Save the schedule to related folder, setting of the Export Schedule as following: 

 
 
(c) Open “txt” file in Excel. 
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(d) Set the “Text Import Wizard” Step 1 to Step 3 as following: 
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(e) Further manipulation can be done in Excel. 
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7.5 Schedule/ Material Takeoff Template 
 

 to incorporate the details of a new project into an existing schedule template, to create a new 

schedule for a new project. 

 

Method 1: Import previous project schedules in a new project 

Step 1 

Refer to the new project. 

Go to Insert Tab  Import Panel  Click Insert from File  Click Insert Views from File 

 

Step 2 

In Open dialog, open the previous project or schedule template. 

 

Step 3 

In Insert Views dialog, select the schedules that need to copy into the new project. 

 

Step 4 

Go to Project Browser, the schedules have been copied to the new project.  



BIM Guide for Cost Estimation 
 

   
Quantity Surveying Branch, ArchSD Page 340 First Issue Date: Dec 2019 
BIM Guide for Cost Estimation (Version 3.1)  Current Issue Date: Dec 2023  

 

Method 2: Use “Copy to Clipboard” 

Step 1 

Open previous project. Go to Project Browser, select the schedules, right click and select Copy to 

Clipboard. 

 

 

Step 2 

Refer to the new project. 

Go to Modify Tab  Clipboard Panel > Click Paste  Click Paste from Clipboard 

 

 

 

 

 

 

 

Step 3 

Go to Project Browser, the schedules have been copied to the new project. 
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7.6 New Material 
 

Create a new Materials 

Step 1 

Go to Manage Tab  Setting Panel  Click Material 

 
 

Step 2 

In the Material Browser dialog, you can (1) duplicate an existing material or (2) create a new material 

from scratch 

For using the duplicate method: 

Select the material  right click  Duplicate 

For using the toolbar: 

Click the button   Create New Material 
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7.7 Paint Function 
 

Apply paint to the face of an element to calculate the elements’ area in model 

Step 1 

Activate the 3D View 

Step 2 

Go to Modify Tab  Geometry Panel  Click Paint 

 
 
Step 3 

In the Material Browser dialog  Search the keyword  Select the material 

 
 
Step 4 

And paint the material into the object’s surface (the color of painted area will be changed to material 

shading color). 

 
Step 5 
The results of painted area will be shown into the Material Takeoff. 
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7.8 Export to IFC 
 

Step 1 

Go to File tab > Click Export  Click IFC, save the “ifc” file in the proper folder. 
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7.9 Quantification 
 

 to count building components automatically 

[Quantification feature is available for Navisworks Manage and Navisworks Simulate users. Navisworks 

Freedom (the free viewer) does not have the necessary functionality.] 

 

Step 1 

Go to Add-Ins tab  External Tools  Click Navisworks  Save the model (.nwc) to related folder 

 

 

Step 2 

Open the model (.nwc) in Navisworks Manage or Navisworks Simulate users. 

 

Step 3 

In the Home tab of the ribbon, select Quantification. 
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Step 4 

Click the Project Setup button. 

 

 

Step 5 

And select the specification catalogue. In our case, we will use None. None for all take-offs since CSI-16, 

CSI-48 and Uniformat are all US standards and are not applicable to Hong Kong. 

 

Step 6 

Ensure the correct unit of measurement is selected. 
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Step 7 

And select, or deselect, which properties are of interest. 
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Step 8 

A blank workbook opens. Now you need to select all the items for take-off and drag them into the white 

pane on the left, you can select from the Selection Tree. 

 

The items are automatically categorised according to whichever schema selected. 

 

Step 9 

The items are automatically colour coded. And can be viewed and overridden if required. 
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Step 10 

Finally, in the top right-hand corner of the Quantification Workbook tab, there is an icon with two blue 

arrows. This is the import/export dialogue. Click on the button. And select Export Quantities to Excel. 

 

 

Step 11 

The workbook is exported to Excel and automatically generated: 

 RAW data tabs 
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 Pivot table (Itemized all items and categorized by level > categories > type) 

 

 Groups Pivot table (Group all items and categorized by level > categories > type) 
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7.10 Useful Keyboard Shortcuts 
 

General 

KS Open Keyboard Shortcuts 

VV Open Visibility/Graphics 

BX Open Section Box 

PT Apply Paint 

Select/Hide/Isolate 

IC Isolate Category 

HC Hide Category 

HI Isolate Element 

HH Hide Element 

HR Reset Temporary Hide/Isolate 

SA Select All Instances: In Entire Project 

Zoom 

ZA Zoom All to Fit 

ZO Zoom Out 
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7.11 Useful plugin 
 

DiRootsOne 

 Allow exporting the selected parameters from the models catergories / annotation catergories / 

elements / schedules / room to Excel format. It also allows filling in data and importing it back into 

the project. 

 Manages parameters using a user-friendly embedded shared editor. It enables creating new 

parameters, modifying existing parameters, and exporting/importing parameters to/from Excel and 

Shared Parameter files. 

 Quickly finds the objects in models by searching by category, parameter name, and value. It can 

also colorize elements based on the values of their parameters. 

 

Step 1 

Download DiRootsOne from the App Store and install it on your computer

 

 

Step 2 

After installation, select DiRootsOne tab in the ribbon.  

 SheetLink: This tool allows you to export/import data to/from Excel. 

 ParaManager: This tool helps you manage parameters. 

 OneFilter: This tool enables you to quickly find objects in models based on specific criteria. 

 

  
(Step 3.1) (Step 3.3) (Step 3.2 & 3.4) 
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For illustration purposes, we need to enter the data into the shared parameter "Deduct slab thickness" 

for each structural column in order to calculate formwork height of structural column. 

 

Step 3.1 – Using ParaManager 

Click Add Parameter to create a new parameter  enter the parameter name, select the type of 

parameter, choose a group to assign it to, and specify whether it is an instance or type parameter. 

 
* Import/Export - You can also import/export parameters from/to Excel or Shared Parameter files(.txt) 

 go to Categories tab, assign the categories for the parameter you created  click OK  click 

Apply to complete. 

 

* Save - You can save a frequently used selection group to expedite future selections. 

* 

* 

(2) 

(3) 

(4) 

(1) 

(5) 

(6) 

(7) 

(8) 
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Step 3.2 – Using SheetLink 

Select Model Categories, click the Select Categories and Available Parameters to choose the 

parameters you want to export  click Export  click Excel to export the selected parameters to Excel. 

 
* Elements – if the exportation only applies to specified elements 

 

* * 
(1) 

(2) 

(3) 

(4) 

(5) 

You can select those family 
parameters that cannot appear 
in schedules, such as structural 
columns’ breadth and depth. 

(6) 
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* Schedules – direct export the created schedule to Excel 

 

 An Excel file is automatically generated with unique Element ID and the selected parameters in table 

form. 

 
 Save the existing profile for further editing. 

 

(1) 

(2) 

(3) 
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Step 3.3 – Using OneFilter 

(1) Visualize - Assign different colors to elements based on specific criteria, such as slab thickness. 

 

 Click on Visualize  select the category  select the parameter  click Apply Colors to colorize 

the elements based on the parameter values 

 

 

  

(1) 

(2) 

(3) 

(4) 

* 

* Randomize – change the appearance colour 

* Reset Overrides – clear the Visibility/Graphic 

Overrides applied to active view 

* 

* Export – you can export the 

selections with a colour legend in 

Excel 

* 
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(2) Filter - Find elements by categories and filter with parameter value 

 

 

 

(3) Rules & Sets – Filter by more than one criterion 

 

Press the keyboard arrow down “↓” 
to see the options 

Isolate the selections 

(1) 

(2) 

(3) 

(4) 
(5) 

(6) 

(1) 

(2) 

(3) 

(4) 

(5) 
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(4) Contains – Find all the selected category elements within Rooms, i.e. Rooms vs Doors, Rooms 

vs Ceilings, Rooms vs all categories, etc. 

 

 Click Rooms  select category or select all categories  in the third column of the Select Room, 

you may select Level for supplementary room details  select the room you are looking for or select all 

rooms  click Find  

  

  

  

 

 

 

 

  

(2) 

(1) 

(4) 

(5) 

(6) 

e.g. in Office 1 
contains 4 kinds 
of ceilings. 

You may add the Room’s 
information in the Define Value. 

(3) 
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Step 3.4 – SheetLink 

With the help of OneFilter, identifying and entering the data into the Excel file is much easier. 

 

 

 Select the saved profile that contains the exported Excel file  click Import from Excel to import 

the data from the Excel file into the model  the model will be updated. 

  

 

 

 

Apply formulas in Excel for calculation 

(1) 

(2) 

Parameters in the model 
will be updated accordingly. 
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